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Overview   
The DDE no longer standardizes on the one model per DGN File sheet production workflow that 
was used in the SELECTSeries DDE. Each Contract Sheet DGN will contain several Design, Drawing 
and Sheet Models. 

Creating a Sheet Model for publishing a PDF typically involves working with the following 
components: 

• Design Model(s) — where the Base Models are referenced in to.  
• Saved Views — Used to set up views required for the drawing. 
• Border Cell — Contains the border graphics and title block. 
• Drawing Model — Contains annotations, dimensions and callouts. 
• Sheet Model — Contains a Border Cell, Sheet Boundary (plotting shape) and may also 

have annotations, dimensions and callouts. 

Two methods are used to create Sheet models, one that scales the border to enclose the design, 
or the other that scales the design to fit the border. 

With both methods, for 3D work in particular, it is a good idea to have separate files one for design 
models and another for the drawing and sheet models. This lets users keep the purely drawing 
information, such as text and dimensioning, separate from the design information. Doing this 
reduces the likelihood of conflicts where others who wish to reference the same design model. 

This process is similar to how the manual draftsperson works. Where it differs, however, is that 
instead of redrawing the model's geometry for each view, like the manual system requires, users 
simply attach views of the design model as references. Users attach as references views of their 
design geometry for each plan, elevation, section, and so on. The power of this system is that any 
changes made to the design model then is reflected immediately in each affected view in the 
drawings. 

 Scaling the Design to Fit the Sheet Border 

The sheet border cell is placed at full size and the design information is scaled up or down to fit 
inside the border, similar to how drawings are created with manual drafting. All text and 
dimensioning are placed at full size. When you create a Sheet model, you select Full Size for the 
Annotation Scale. 

In this case, with Annotation Scale set to Full Size, the sheet boundary element appears at its real-
world size (not scaled). This is a non-printing element that shows you the outer limits of the sheet 
size that you choose. The CTDOT Cell border will be placed at Full Size (with no scale factor) and 
dropped onto the sheet boundary. 

References of the design are placed at the appropriate scales as required, to fit inside the 
sheet/border layout. For a 1/2" = 1'-0", or 1:24 scale drawing, the design model references will be 
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placed in the Sheet model at a scale of 1:24. Similarly, any details that are at different scales are 
simply referenced at the required scale. For example, a 1/4" = 1'-0", or 1:48 scale detail would be 
referenced at 1:48 scale. 

When attaching a reference (a design or drawing model) into a sheet model, the referenced 
model's annotation scale is applied as the detail scale, and the Reference Scale (Master:Ref 
Scale) is calculated from the referenced model's annotation scale and the active model's 
annotation scale. 

Uses: 
• Miscellaneous Detail Sheet 
• Typical Sections Sheet 

 Scaling the Sheet Border to Fit the Design 

The sheet border cell is scaled up (or down) to cover the required area in the design, all text and 
dimensioning must be scaled the same amount, also. This is to ensure that when the scaled print 
is created, text and dimensioning elements are at the correct physical size. 

To simplify this process, when users create a Sheet model, they have the option of associating an 
Annotation Scale to it, as well as a sheet boundary size. Additionally, if required, users can specify 
the origin of the sheet boundary and its rotation. 

When an annotation scale is specified, the Sheet Boundary element also is scaled by that amount. 
This is a non-printing element that shows the outer limits of the sheet size that was chosen. To this, 
users then can attach the CTDOT border, to which you apply the same scale factor as that for the 
Sheet model. Additionally, any text that you place in the Sheet model, with the Annotation Scale 
lock enabled, automatically will be scaled by the same amount. For example, if you are creating a 
1" = 40' scale drawing, any text that you place would have to be 480 times bigger than normal so 
that it prints at the correct size. 

Uses: 
• Plan View Sheet 
• Profile View Sheet 
• Cross Sections View Sheet  
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Section 1 – Review of Standards 

1.1 Contract Plan grouping 
Contract plans shall be grouped, by discipline into individual multiple page PDF files called 
discipline subsets.  The PDF order will dictate how the CAD files are organized and how the Title 
Blocks Cells are annotated. The project manager is tasked with determining the discipline 
subset numbering and grouping.   The first sheet in a discipline subset shall have “01” in the 
drawing number CAD DGN file. 

1.1.1 Drawing Number vs Sheet Numbers 

• The drawing number is used primarily for sheet to sheet linking, typically in, but not 
limited to, section details, section cuts, and detail callouts. Drawing Numbers are 
placed in CAD files, they consist of the discipline/sheet type designator followed by a 
hyphen and a number.   Examples of drawing number prefixes can be found in Volume 
16 of the DDE, Appendix 5.   

• Sheet numbers are applied to the discipline subset after the contract plans are 
published to PDF. Please review the DIGITAL PROJECT DEVELOPMENT MANUAL, Section 
6, Document Preparation and Format for detailed instructions. 

 
Figure 1 - Title Block Drawing Number and Sheet Number 

The first page of each subset shall be a subset cover sheet, this includes FIO subsets. This 
cover sheet shall contain both; an index of drawings contained within the subset that 
includes both drawing numbers and drawing titles and the form field place holder(s) which 
receives the digital signatures. This table must include the subset name and number 
displayed as a heading. 

https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf
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1.1.2 Examples of the subsets 

Please refer to Volume 16 of the DDE, Appendix 5 for Drawing Number abbreviation pre-fix 
list 
01-General 
• Title Sheet - The first page of the subset 01_General includes 

o an index of the subsets contained within the project 
o sheet count totals for all subsets 
o a list of drawings for the 01_General Subset 
o an area(s) reserved for applying the digital signature(s) 

• Additional Location Plans 
• Detail Estimate Sheet(S) 

02-Revisions 
• The Index of Revisions Sheet(s) 

03-Highways 
• Index of Drawings 
• Index of Plans 
• Survey Control Data 
• Alignment Plans 
• Right of Way Plans 
• Typical Sections 
• Highway Plans 
• Drainage Plans 
• Sedimentation and Erosion Control 

Plans 
• Profile 

• Cross Sections 
• Site Grading Plans 
• Intersection Grading Plans 
• Miscellaneous Detail Sheets 
• Superelevation Diagrams 
• Boring Logs 
• Test Pit Data 
• Staging Plans includes 

o Plans 
o profiles 
o cross sections 

 
04-Structure 
• Index of Drawings 
• All Structure Sheets - Multiple subsets may be required for multiple Sites Ex: 

04_Structure_Br.No.1266  

05-Traffic 
• Index of Drawings 
• Signing Pavement Markings Plans 
• MPT Plans 
• Traffic Signal Plans Etc.  
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06-Illumination 
• Index of Drawings 
• All Environmental Compliance Sheets required  

07-Utiltiy 
• Index of Drawings 
• Utility Design plans.  

08-CL&P FIO 
• CL & P For Information Only plans are submitted in PDF – No CAD required.  See 

the Digital Project Development Manual for instructions for creating this subset.  
• 09-AT&T FIO 
• AT & T For Information Only plans are submitted in PDF – No CAD required.  See 

the Digital Project Development Manual for instructions for creating this subset. 

CTDOT Highway STD CTDOT 
Highway Design Standard Index and Sheets required are created in Bluebeam – No CAD 
required.  See the Digital Project Development Manual for instructions for creating this 
subset. 

CTDOT Traffic STD CTDOT 
Traffic Engineering Standard Index and Sheets required are created in Bluebeam – No CAD 
required.  See the Digital Project Development Manual for instructions for creating this 
subset. 

https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf?la=en&hash=DD9E2489507849A198170DF62C3606A4
https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf?la=en&hash=DD9E2489507849A198170DF62C3606A4
https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf?la=en&hash=DD9E2489507849A198170DF62C3606A4
https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf?la=en&hash=DD9E2489507849A198170DF62C3606A4
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1.2 The Contract Border Title Block Integration 

1.2.1 WorkSet Project Information 

The Project Number, Project Description and Towns will be automatically populated from 
the WorkSet Properties, there is no need to enter or edit any of this text. 

Note: Older Border Cells placed prior to March 2023 point the CONNECTED Project 
Properties, moving forward CTDOT will use the CTDOT WorkSet Properties. Previously set up 
CONNECTED Project Properties will stay in place to accommodate the older border's title 
block integration. 

  
Figure 2 - Title Block 

1.2.1 Drawing Title 

The Drawing Title will be populated with the text entered in the Modal Description Field. 



VOLUME 13 – Contract Plans Production 

3 
 

 
Figure - 3 Drawing Title 

1.2.2 Designed and Checked By 

There are two options for filling in this information: 

Note: Please refer to your supervisor to determining if Initials or First Initial. Last name will 
be used. 

• Manual - Use the Text Editor to enter the Design/Drafter and Check By names.  This 
is generally used when creating a blank sheet model and manually placing the 
border cell. 

 
Figure 4 - Title Block Designer / Drafter / Checked By 



VOLUME 13 – Contract Plans Production 

4 
 

• Automated – Update fields through Item Types. The Engineer Name Item Type has 
been added to all Sheet Seeds.  Sheet models created using the sheet 
production, Place Named Boundary Tools and Detailing Tools will have this process 
available. Multiple models can be selected and updated at one time through 
the Properties Dialog Box under Engineer Name. 

 
Figure 5 - Title Block Designer / Drafter / Checked By Item Type 

 



VOLUME 13 – Contract Plans Production 

5 
 

1.2.3 Drawing Number 

The DRAWING NO. box will be populated by filling in the Sheet Number on the Properties 
Dialog Box. 

Note: The SHEET NO. box will remain blank in the CAD file, this will be populated in the 
discipline subset after the contract plans are published to PDF. Please review the DIGITAL 
PROJECT DEVELOPMENT MANUAL, Section 4, Contract Plan Drawing and Sheet Numbering for 
detailed instructions. 

 
Figure 6 - Sheet Number is Drawing Number 

  

https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf
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1.2.4 Revision Block 

The Revision Block can be filled in by using the Edit Text command and clicking on the Data 
Fields, this will prompt the Text Editor to open. Note: Blank Data Fields can be made visual in 
the View Attributes dialog box.  

 
Figure 7 - Revision Block 

1.2.5 Last Saved By and File Name 

These fields will auto-populate with the username and file path. 

 
Figure 8 - Last Saved By / File Name 
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1.2.6 PDF Text 

Please review the DIGITAL PROJECT DEVELOPMENT MANUAL, Section 6 annotation placed in 
the PDF plans 

The following will be created in the PDF not in the CAD file: 

1. The Plotted Date will populate when the PDF is Created. 

  
Figure 9 - PDF Plotted Date 

2. The Signature Block info will also be placed as a stamp in the PDF. 

3. Sheet Numbering 
4. The following Stamps are available to be placed in the bottom Right above the Title 

Block of the PDF as needed: 
o ADDENDUM NO. Y 
o DESIGN INITIATED CHANGE ORDER NO. Y mm/dd/yy 
o NEW SHEET ADDED BY ADDENDUM NO. Y 
o NEW SHEET ADDED BY DESIGN INITIATED CHANGE ORDER NO. Y mm/dd/yy 
o DESIGN REVIEW STAMPS 

Note: If there is no room above the Title Block these stamps can also be placed in 
the margin below the Title Block 

 
Figure 10 - Stamps 

Instructions for downloading the Stamps to the CTDOT Bluebeam User Profile 
1. Click on the link below and download the zip file. 

ctdot_bluebeam_user_profile 
2. In File Explorer, browse to the downloaded location, it will most likely will show up in 

the Downloads folder. Double click on the user profile in the zip folder and the file will 
automatically install.  

https://portal.ct.gov/-/media/DOT/documents/AEC/digitalprojectdevelopmentpdf.pdf
https://portal.ct.gov/-/media/DOT/documents/AEC/CTDOT-Bluebeam-User_profile.zip?sc_lang=en&hash=8468D51CE40B06E628C7F982717BCEB7
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1.3 Tables 
You can place tables in CONNECT Edition using the Place Table tool. Once placed, you can 
perform following formatting operations on a table: 

• Add and remove rows 
• Add title row, header row, first column, last column, and footer row, which can 

contain different formatting then the body rows 
• Break a table 
• Change height and width of rows and columns 
• Merge and split cells 
• Change cell margins 
• Set cell fill color 
• Add and remove borders 
• Set border color, line style, and line weight 

You can also perform following operations on the text in the table cells: 
• Set text alignment 
• Set text direction 

 
Figure 11 - Tables 

You can also place a table using the data in an excel workbook or a .csv file. 

If you have a report definition created, the report can be placed as a table in your model. The 
content in the table is automatically populated from the report definition. 

You can also place a sheet index as a table. 

1.3.1  Table Seeds 

Table seeds are available in the CTDOT DDE to use while placing a table in your model. A 
table seed can contain properties, formatting, and style settings that are inherited by the 
table. 
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1.3.2 Place Table Tool 

You can access this tool from the following: 
• Ribbon: Drawing > Annotate > Table 
• Explorer dialog Sheet Index tab: Place Sheet Index as a table 
• Reports dialog: Place as table 

 
Methods: 

• Empty table - Lets you place an empty table. 
• From report - Lets you place a table from a report definition. 
• From file - Lets you place a table using the data in an excel workbook or .csv file. 

    

 
Figure 12 - Place Table Options 

Options: 
Seed - Lets you select a seed for the table. If you select to place a table from a Microsoft 
Excel file, you get an option "From Excel" in this drop-down list. If you select it, OpenBuildings 
Designer attempts to preserve the formatting such as colors, borders, text direction, text 
justification, fonts, font styles, font sizes, row/column/cell sizes, and cell margins. 

Annotation Scale - Sets the Annotation Scale Lock. When this lock is on, the annotation 
scale is applied to the table and text within the table. By default, the annotation scale is 
taken from the model's Annotation Scale setting. You can change it only in the model's 
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properties in the Properties dialog. The exception is when the model's Propagate Annotation 
Scale property is off. In that case, the annotation scale can be controlled independently for 
each element via its properties. 

Text Style - (Available only when Seed is set to None) Sets the active text style from a list of 
all available text styles. Clicking Browseopens the Text Styles dialog in which you can create 
and modify text styles. 

Active Angle - Sets the angle, in degrees, at which table is placed. 

Row Count - Sets the number of rows in the table. 

Column Count - Sets the number of columns in the table. 

Report - (Available only when From Report is selected) Places the selected report as a 
table. Clicking Browseopens the Reports dialog in which you can create and manage 
reports and report definitions. 

File Name - (Available only when From File is selected) Lets you select a file from which you 
want to place a table. Click Browseto open the File Open dialog and select the desired file 
from which the table is to be placed. If you select a Microsoft Excel workbook, then the 
Select Cells dialog opens, in which you can select the worksheet and cell range.  

The Select Cells dialog has the following options: 
• Worksheet - Lists the worksheets in the selected excel workbook. 

• Range - Allows you to select the cell range of the file that will be placed as a table. If 
set to Automatic, selects the range of cells which Microsoft Excel considers to be the 
"used area" of the sheet. It is usually a rectangle containing all non-empty cells, or 
cells which have otherwise been modified by the user, such as by resizing the rows or 
columns. If set to Manual, allows you to select the range of cells in the From and To 
fields. Named ranges are also supported. 

• From - If Range is set to Manual, allows you to enter the start of the cell range. 

• To - If Range is set to Manual, allows you to enter the end of the cell range. 

Worksheet - (Available only when you select an excel workbook in the File Name setting) 
Lists the worksheets in the selected excel workbook. 

Range - (Available only when you select an excel workbook in the File Name setting) 
Displays the cell range of the file that will be placed as a table. 

Contains Title Row - (Available only when From File is selected) If on, places the first row as 
a title row. 

Contains Header Row - (Available only when From File is selected) If on, places the second 
row as a header row. 
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Retain Association - (Available only when From Report or From File is selected) If on, the 
association with the report or external file from which the table is placed is retained. In such 
a case, if there are any changes in the report definition or the file, you can refresh the table 
to get the changes.  

1.3.3  Refresh a Table 

If you have a placed a table from a report/external file and the Retain Association option is 
turned on, any changes made to the report or the source file can be updated in your table 
using this procedure. 

Select the table. The row and column headings display.  Do one of the following: 
1. Right-click any cell or the row or column headings and select Refresh Table from 

Data Source. 
2. Click the Refresh Table from Data Source icon in the Table Tools contextual tab. 

1.4 Annotation Tools 

All annotation such as: call outs, labels, notes and dimensions are placed in drawing and/or 
sheet models. It is important that the proper tools are selected so the annotation is placed 
using the correct attribution. 

Common Annotation Tools can be found in the Ribbon by selecting the CTDOT Workflow. Users 
will find the needed tools in the Annotation and Dimensioning sections on the CTDOT Tab. 

 
Figure 13 - CTDOT Workflow 
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1.4.1 Call Outs 

 
Figure 14 - CTDOT Call Outs 

There are several call out options available: 
Label (Weight 2) - Used for Plan View Annotation of General Pay Items. 
Small Label (Weight 2) - Used for Plan View Annotation of General Pay Items where space 
maybe limited. 
Label (Weight 0) - Used for Detail Annotation. 
Small Label (Weight 0) - Used for Detail Annotation where space maybe limited. 
Non-Pay Item – Used for items that remain in place, or become the property of the 
contractor, or to be saved and no associated cost/pay is incurred. 
Paid by Others - Is usually for utility items, such as poles to be removed, replaced or placed 
by the utility companies.  Any work that is not performed by the project contractor will be 
called out with this item. 
ROW – Used for Right of Way items such as but not limited to Taking Line, Construction Line 
and Drainage Right of Way (D.R.O.W.).    
Begin Project Limits – Used to define the beginning of project, this note will include the 
following information: 

Begin Project No. XXXX-XXXX 
F.A.P. NO. XXXX(XXX) 
CL STA. XX+XX 
Northing Coordinate 
Easting Coordinate 
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Limits of Construction – Used to define the limits of construction on intersecting roadways, 
this note will include the following information: 

Limits of Construction 
CL STA. XX+XX 
Northing Coordinate 
Easting Coordinate 

End Project Limits – Used to define the end of project, this note will include the following 
information: 

End Project No. XXXX-XXXX 
F.A.P. NO. XXXX(XXX) 
CL STA. XX+XX 
Northing Coordinate 
Easting Coordinate 

The Circle and Hexagon call outs can be used as needed to annotate Plans and Details. 
  



VOLUME 13 – Contract Plans Production 

14 
 

1.4.2 Notes 

Notes are used to convey information such as right of way and construction 
sequencing. General Notes are usually found on the first plan view sheet of each subset but 
can be placed on any sheet as needed.  The Notes Tool is also used for Legends on Typical 
Section Sheets, Notes on Detail Sheets and for Row Legends. Tools to place annotation for 
Existing Features, Match Mark Lines and Match Mark Text are also located on this Menu. 

 
Figure-  15 CTDOT Notes 

  

General Notes can also be placed in a table.  A Table Seed for General Notes is provided for 
this use.Tables will allow auto-return of text when the width is adjusted. 

 
Figure 16 – General Notes Table Dialog Box 

    

Figure 17 - General Notes Table Editing 
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1.4.3 Dimensions 

The Set Style tools in the Dimensioning section will set basic attributes for dimensioning. 
After choosing one of these options a Placement Tool will need to be selected. 

 
Figure 18 – CTDOT Dimensioning 

After a Placement Tool is activated a dialog box will appear, users can now select the 
needed options to get the desired output for the Dimension. 

  
Figure 19 CTDOT Dimensioning Options 
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1.4.4 Annotation Attribute Pointers 

The example of how an annotation tool calls for the correct Annotation Attributes is detailed 
below. 

 

Figure 20 - Annotation Attribute Pointers 
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1.5 Screening for PDF Creation 

The Pen Tables delivered with the CTDOT CONNECT DDE gives the user the ability to set 
screening options when PDF files are created. 

…CT_Configuration\Organization\Pen_Tables 

 
Figure 21 – PDF Plan 

Users can direct the PDF to create with certain reference files screened by using a wildcard in 
the DGN reference file’s logical name. 

• If the reference logical name begins with “screen” the output weight is 2 
• If the reference logical name begins with “one” the output weight is 1 
• If the reference logical name begins with “sww” the output weight is unchanged 

 
Figure 22 – Reference Screening 
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Wildcard Examples: 
Screen – Shows as screened with a default remap line weight of 2 when the PDF is 
created.  Example Logical Name: Screen Ground Survey 
one - Shows as screened with a default remap line weight of 1 when the PDF is 
created.  Example Logical Name: one Ground Survey 
sww – Stands for “screen with weights”. Shows as screened and will retain the original 
weights of a particular reference file when the PDF is created.  Example Logical Name: sww 
Ground Survey 
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1.6 Level Display in Plan Sheets  

A better understanding of how OpenX Products handles new levels and the level display of 
nested references with display overrides is needed to determine how to change the level 
display in sheet models when the source data is attached as a nested reference. This section 
will be helpful to review before using the Place Named Boundary tools.  When the drawing 
boundary seeds are used to automatically create drawings from data attached as a nested 
reference, an additional type of level display control is used called Synchronize View.  

 
Figure 23 - Place Named Boundaries 

Sheets can be manually created using reference attachments and when manual reference 
attachments are made, the default settings for reference attachments allow the level display 
to be controlled entirely in the Sheet Model.  

New Level Display Setting 
The display of information on new levels is controlled globally through a configuration variable, 
MS_REF_NEWLEVELDISPLAY. When elements are added to new levels in the source data, those 
referenced levels will be toggled on for display in the sheets automatically. The automatic 
turning on of new levels makes it easier for downstream users of referenced design files to be 
aware of additional design work that has been drawn in a file.  
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Sheet Container File 
When working in the CTDOT Workspace and using the CTDOT preference seeds, level display in 
the sheets is most easily controlled from the Design Model (Assembler) of the container file. As 
it is explained below, the Synchronize View setting, for the reference to the source data, is set to 
display the levels that are turned on in the Design Model (Assembler). Any changes to the 
displayed levels in the sheets are temporary. This is by design. The level display can be reset 
and saved in individual sheets, but the reference attachment settings that synchronize the 
view will need to be modified in the Drawing Model first. 

Definitions  
• CP (Contract Plan) – multiple sheet models such as Plans and Profiles can be generated in 

a dgn file. The Contract Plan file is a container file. The Default model contains references to 
source data and named boundaries for production of drawing and sheet type models.  

• Design Model (Assembler) – This model contains the direct References to the Contract 
Base Models, Existing Survey Terrain Models, and Existing Ground Models. This will be the 
Default model of an CP file. 

• Drawing Model (Annotation)– This model type is the link between the Sheet and Design 
model in the CP file.  They house the Saved View of each Named Boundary. 

• Sheet Model (Publishing Portal)– This model that contains your assembled sheet is the 
model that you print from. This sheet type model contains a plotting shape and border cell 
with the title block information. A Sheet Model is the only model type that includes the 
ability to Number Models. CTDOT uses the sheet number field to fill in the Drawing Number.   

• MS_REF_NEWLEVELDISPLAY is a variable that controls whether you automatically see 
additional information on previously unused levels in any reference file – direct attachment 
or nested reference. In the CTDOT WorkSpace, this variable is set to true. It is critical for new 
information drawn in a design to automatically be shown in the sheet. When designers 
update their source data, and use new levels, that information will automatically display in 
the assembled sheets.  

• Reference / Display Overrides affect nested references only when Synchronize View – 
Setting from Design Model is not used and sets where the level display takes place. 
Because it is important that the level display be able to be controlled from the Sheet Model, 
the default preference for reference attachments is set and locked to “Always”, so that the 
sheet level display always overrides the source or parent. If it is your intention to control the 
display of levels in the sheet from the original reference to the source data, you may 
change the sheet nested reference attachment setting to “Never” after the attachment 
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has been made. A setting of “Never” makes level display changes in the sheet temporary – 
they can never permanently override the display of the levels from the source data. 

1.6.1 Synchronize View and Adjusting the Level Display 

When sheets are automatically created using named boundaries, the drawing-type model 
that is created uses a setting on its reference attachment to the parent model, called 
Synchronize View and it is set to “Settings From Design Model”. This setting prevents level 
display changes in the sheet from being permanent. To permanently change the level 
display in the sheet, the level display in the Default (Design Model (Assembler)) model 
must be changed and those level display settings will propagate through the drawing-
type model to the sheet.  

Note: When Synchronize View is set to “Settings From Design Model”, changes to the level 
display in the Default model will affect the level display of every sheet created from a 
named boundary in the Default model. 

When level display changes need to be made to just one sheet model, the Synchronize 
View reference attachment setting in the drawing-type model that is the source for the 
sheet, can be changed to “Presentation Only” or “Volume Only”. “Presentation Only” allows 
the levels to be controlled from the sheet model, the setting of “Volume Only” allows both 
the level display and the clipping boundary to be modified in the sheet.  

How Synchronize View Settings in Drawing Models Affects the Sheet Model  
Settings From 
Design Model 

In the sheet model, the clip boundary commands do not function; level 
display changes are temporary. Adjustments to level display or named 
boundaries must be performed in the design model (Default). 

Presentation 
Only 

In the sheet model, the clip boundary commands do not function; 
adjustments to named boundaries must be performed in the design 
model (Default). Level display changes that are made in the sheet are 
saved. Level display changes in Default do not affect the sheets whose 
drawing models use Presentation Only. 

Volume Only In the sheet model, the clip boundaries may be reclipped or removed. 
Adjustments to named boundaries in Default do not affect the sheets 
whose drawing models use Volume Only.  
Level display changes that are made in the sheet are saved. Level 
display changes in Default do not affect the sheets whose drawing 
models use Volume Only.  

None  
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1.6.2 Synchronize View Set to Presentation Only or Volume Only 

The following information is valid only when not using Synchronize View set to Settings From 
Design Model. “From Design Model” will be used when the sheets are initially created, the 
drawing Models references can be set post process to Presentation Only or Volume Only 

Using a CP (Contract Plan), can reduce the number of direct reference attachments to a 
plan sheet. Another benefit is that the Reference Attachment Settings provide the ability to 
choose where to control the level display of the nested base references. The Display 
Overrides allow you to set which model controls the level display - either the plan sheet 
itself, or the Assembler Model. A default reference attachment setting currently sets the 
Display Override value to “Always”. When the initial reference attachment is made, the 
levels in the sheet display the same as the levels in the model that is attached as a 
reference (parent). The setting of “Always” lets you perform level display changes in each 
individual sheets. 

 
Figure 24 - Hierarchy of Plan Sheet Assembly 

Display Overrides  
Allow Design Model is allowed to override the Drawing Model or Sheet Model until 

settings are changed or saved in these parent models. After parent settings 
are changed or saved, the Parent settings always override the Child Model. 

Always Drawing Model or Sheet Model settings for level display of reference levels 
ALWAYS override the Design Model. 

Never Design Model settings for level display of reference levels NEVER OVERRIDE the 
Parents - Design Model rules 

 

Note: Save Settings (on Exit) – The use of the command File > Save Settings in the Plan 
Sheet or setting your workspace preference “Save Settings on Exit” effectively reduces the 
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Display Overrides to just two: Always or Never. After settings are saved in the Plan Sheet, 
Allow acts just like Always. 

Out Comes 
Allow with Save Settings on Exit / Always Never 
I want to control the level display from the 
plan sheet file. 
 
If I use a Design Model (Assembler), I will 
set the level display up for my plan sheets 
in the CAD Base file before I attach it as a 
reference. 
 
Adjustments to the level display in each 
plan sheet will be performed in the plan 
sheet file on that specific reference 
attachment. 
 
If I open the Design Model (Assembler 
Model) and make level display changes 
there – those changes will NOT be seen in 
my plan sheets.  
 
Parent Model rules 

I want to control the level display in all plan 
sheets from the Design Model (Assembler). 
 
I will set the level display up for my plan 
sheets in the CAD Base file before I attach it 
as a reference.  
 
When I need to change level displays in a 
plan sheet, I open the CAD Base file and 
make the change there.  
 
The CAD Base file level display will now be 
seen in all of the plan sheets.  
 
 
 
 
 
Design Model (Assembler Model) rules 

 
Changing the Display Overrides 
Display Overrides may be changed from Always to Never on any nested reference 
attachment(s) to dynamically see level display settings in the CAD Base file. If you wish to 
keep the new choice, save the settings before exiting the file. Also, be aware that Never 
passes reference display on/off toggles to the Master file and reverting to Always does not 
reset a display toggle change. If a nested reference was toggled off while changing the 
Display Overrides, you will have to manually toggle it back on. It is because of the reference 
display toggle behavior that it is recommended to maintain a separate CAD Base file for a 
plan sheet assembled with a different set of discipline base files, such as a drainage plan. 
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Section 2 - General Workflows 

2.1 Startup  

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenX Applications through Accounting or the Customized Icon following  

6. On the OpenX Splash Screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

2.2 Assembling the General Subset 

2.2.1 Town Road Maps 

Before the Project Title Sheet is created, the Town Road (TRU) Map(s) for the town(s) where 
the project is located needs to be copied into the Project Container (WorkSet folder). 

1. These Maps can be found on CTDOT's Website, Town Road Maps Page. 

2. Locate the town(s) needed for your project and download the required DGN File(s) to 
your project directory under …\Share. All Design and Survey Units have access 
permission to this folder. This central storage location will prevent multiple copies of 
the same maps and images in a project container. Any acquired files from Google 
Maps, Aerial Images, LiDAR Data or other resources should also be stored in this 
folder. 

https://portal.ct.gov/DOT/PP_SysInfo/Town-Road-Maps
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Figure 25 - Town Road Maps Web Page 

2.2.2 Title Sheet 

The Title Sheet is the cover page for all Connecticut Department of Transportation (CTDOT) 
Capital Projects Plan Sets. The title sheet identifies the subsets of plans, conveys the general 
type of work planned, and locates the project within the State.  

The title sheet includes: 
• Project Title 
• Town(s) and/or City(s) 
• Route Number and Length 
• F.A.P. Number 
• Project Number 
• Connecticut Map & Town Map 
• Location Plan 
• List of Subsets 
• Signature Fields 
• Total number of plan sheets 

It is important that the Title Sheet is created early in the design process, so it can be 
attached to concept plan sets, preliminary plan sets and all other required/needed plan 
sets. The title sheet should be kept up to date at all times. The signature fields are not 
required until FDP submittal or as required by the Digital Project Development Manual 
(latest version). The title sheet is standardized, and no modifications should be made other 
than as described in the steps below. 
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Figure 26 – PDF Blank Title Sheet 

The Title Sheet for each project is created by the lead discipline (unit). The lead unit is 
responsible to create the Title Sheet and assign the Subset numbers for each of the 
disciplines. Subset numbers 01 & 02 are reserved for General and Revisions respectively. The 
next subset number 03 is for the lead unit. Other subset numbers follow as needed. The lead 
discipline’s project engineer should notify the other disciplines of the subset numbers 
assigned. 

1. To create a project title sheet, click on the New File icon. Click on the Browse button to 
select the CTDOT Title Sheet dgn seed file.   

…\CT_Configuration\Organization\Seed\CTDOT_Title_Sheet_Seed.dgn 

2. Browse to the location you would like to save the file to and type in the file name using 
the DDE file naming convention HW_CP_1234_1234_GeneralSubset.dgn 

Click on Save. 

3. Fit View when the new title sheet file opens. 



VOLUME 13 – Contract Plans Production 

27 
 

 
Figure 27 - DGN Blank Title Sheet 

4. Use the Text Edit command to edit the following Orange text: 

• Project Title 
• Town Name in the center of the sheet and in the bottom right box. 
• General notes 

o Add the F.A.P. # 
o Update the specification form and supplement year as needed. 
o Delete either NAD 1927 or NAD 1983. 
o Delete either NGVD 1929 or NAVD 1988. 
o For Surveyed by: list the surveyor of record (examples - District 1 or ABC 

Company) 

Turn off the levels for items not needed, such as preliminary or semi-final design review, 
etc. Levels can be turned off using Off By Element in the Level Display dialog box or can 
be deleted. The top Maintenance Responsibility notes should be used primarily by 
Highway the bottom by Traffic. 

5. The District Maps shown in the Location Plan area are used for Signal projects. They can 
be turned off in the References dialog box. All other project types will have the TRU Maps 
in the Location Plan Box. To place the TRU Map first turn off the district maps references 
and then reference in the TRU map(s) that were copied into your project directory – 
Shared_Rasters folder. Move, scale, clip to show the location of your project area. Turn 
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off un-needed levels. Clip this Reference file - Use the Location Plan Shape for the 
clipping Boundary Element. Annotate as needed. The location map should be scaled so 
road names etc. can be read. Place a circle to mark the project location. 

 
Figure 28 – Location Plan Are 

6. The town map will be placed under the Maintenance Responsibility note. Reference in 
the TRU map(s), move and scale to fit the whole town map. Turn Off unneeded levels 
and annotate as needed. 

7. To shade Towns, make the MAP_Town_Shade level active. Use the Create Complex 
Shape Tool and select the needed town boundary lines. 

8. Consultant designed projects shall not include the disclaimer located above the 
signature block. This shall be deleted. 

9. Consultants will need to delete the CTDOT signature blocks on the title sheet and place 
a digital signature placeholder as detailed in the Digital Project Development Manual. 

 
Figure 29 - PDF Title Sheet Overview 
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2.2.3 Additional Location Plan Sheets 

The location plan depicts the approximate area(s) of the project location(s). In most cases 
the location plan(s) will fit on the title sheet. Additional space will be needed for the 
Location Plan(s) when a project has multiple locations, towns or is extra-long. The 
additional location Plans will be placed on contract sheets directly after the Title Sheet as 
part of the General Subset for the project. 

1. To house the needed Location Plans, create additional 2D Sheet Models in the General 
Subset dgn. 

2. Place the regular Contract Border Cell to line up with the transient shape. 

3. Reference in the TRU map(s) for the project. 

4. Move, scale, clip to show the location of your project area. Turn off un-needed levels. 
Clip this Reference file and annotate as needed. The location map should be scaled so 
road names etc. can be read. 

5. Place a Circle to mark the project location or On the CTDOT Workflow, CTDOT Tab use 
the notes Begin and End to show the limits of the project, include a North Arrow to orient 
the viewer.  You can also thicken or draw a line to better show the project limits. 

6. Repeat steps 3-5 as needed adding additional location plans or go back to step 1 to 
add additional contract sheet models.    

 

       

Figure 30 – Title Sheet Annotation 

7. Fill in the contract border title blocks, use Location Plan as Drawing Title; include these 
sheets in the general subset under the list of drawings. 
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2.2.4 Detailed Estimate Sheets 

The Detail Estimate Sheets are part of the digital contract plans under the General Subset 
and it contains all the pay items and quantities associated with the construction cost of a 
project. The lead designer will create the detail estimate sheet models and will attach or 
reference in the detail estimates from the other disciplines. 

 
Figure 31 – Detailed Estimate Sheet 

1. Use Excel to enter your detailed estimate information (Pay Items should be listed along 
the top, Sections on left most column and Totals on the bottom, seethe image above as 
an example). Make note of the range of information needed to be brought into each 
DGN model. Example: A1 to H20. Request that the support units do the same and send 
you a link to their excel files. 

2. To house the needed Detailed Estimate Sheets in CAD, create additional 2D Sheet 
Models in the General Subset dgn. One for each sheet needed including those from the 
support disciplines. 

3. Place the regular Contract Border Cell to line up with the transient shape.  

4. On the Annotate Tab select Place Table. For Seed choose From Excel.  Make sure Retain 
Association is toggle on. Browse out the needed excel file.  Choose the 
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correct Worksheet and set the Range to Manual. Set the From/To ranges and follow the 
prompts to place the linked table. 

 
Figure 32 – Attaching an Excel Sheet 

5. Fill in the contract border title block, use Detailed Estimate as Drawing Title; include 
these sheets in the general subset under the list of drawings. 

6. Repeat for each 2- 5 for each sheet needed. 

7. When printing select Monochrome as printing color. 

Place Table from Table Seed 

The CONNECT Edition provided the feature of creating tables in your DGN files. The CTDOT 
DDE provides standard templates that your tables should follow, users can apply them 
while placing tables in models. This feature is called Table Seed. 

The table seed displays in the Seed drop-down list of the Place Table tool settings window. 

 
Figure 33 – Table From Seed 

Please Note: The Table Seed for the Detailed Estimate Sheet is not yet available in the DDE.  This 
will be added into the next release of the CTDOT CONNECT DDE. 
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1. Each disciple will create a DGN file to house the Detailed Estimate Tables. Create a 
Design Model for each table needed and use the Place Table tool in each model. Fill in 
the Table as needed. 

2. These tables will be reference in models in the General Subset dgn. In the General 
Subset dgn create additional 2D Sheet Models, one for each table needed, including 
those from the support disciplines. Reference in the tables creating in step 1. 

3. Place the regular Contract Border Cell to line up with the transient shape.  

2.3 Index of Revisions Sheet 

The Index of Revisions sheet(s) for each project is created and maintained by the lead 
discipline (unit). 

1. To create a Revision Index sheet, within OpenRoads, OpenBridge, OpenBuildings, or 
OpenRail click on the New File icon. 

2. Click on the Browse button to select the Revision Sheet dgn seed 
file.…\CT_Configuration\Organization\Seed\ CTDOT_02_Revisions_Sheet_Seed.dgn 

3. Browse to the location you would like to save the file to and type in the file name using the 
DDE file naming convention. Example: HW_CP_1234_1234_RevisionsSheet.dgn 

4. Click on Save. 

5. Enter the Title Block Information as instructed in the section: Section 1 - Introduction 

6. Select the edit text tool and click in the table to add text.Below is a description of each 
column: 

1| Enter the Addendum or Design Initiated Change Order Revision #. 

2| Enter the revised or new sheet number. 

3| Enter the Date mm/dd/yy 

4| 5| 6| Enter a Bold Capital X in the appropriate box per row to describe the action taken, 
new sheet, revised sheet, or sheet deleted. 

7| Enter a brief description that is like the description on the actual sheet being revised. 

Note: The Engineer is not required to input changes numerically by Sheet No. If another 
changed sheet is added to an Addendum in the eleventh hour, it can be placed at the 
bottom of the list on the “Index of Revisions Subset”. 

7. On the CTDOT Workflow, CTDOT tab in the Publishing section, select Print\Browse to Print. 

8. Select the desired location to save the file.When complete move the PDF file to the 
project’s Contract Documents / 100 Contract Plans folder. 

https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-013---contract-plans-production/section-1---introduction#THE%20CONTRACT%20BORDER%20TITLE%20BLOCK%20INTERGRATION
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9. Now proceed with Bluebeam tools to: 

• be digitally signed 

• add the Sheet Numbers 

• place the ADP/DICO # stamp 

10. Use the same DGN file to add Addendum or Design Initiated Change Order Revision # lines, 
keeping the old lines intact. 

11. If you have filled the sheet create another file 
new HW_CP_1234_1234_RevisionsSheet2.dgn and repeat the steps above. 

 
Figure 34 - Index of Revisions Sheet 
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2.4 Discipline Subset Cover Sheet / Index of Drawings 

1. To create a Subset cover sheet, within OpenX products click on the New File icon. 

2. Click on the Browse button to select the CTDOT Cover Sheet dgn seed file.   

…\CT_Configuration\Organization\Seed\CTDOT_State_Cover_Sheet_Seed.dgn 

or 

…\CT_Configuration\Organization\Seed\CTDOT_Consultant_Cover_Sheet_Seed.dgn 

3. Browse to the location you would like to save the file to and type in the file name using the 
DDE file naming convention HW_CP_1234_1234_SubsetCoverSheet.dgn 

4. Click on Save. 

5. The file will open with the Drawing Title and Drawing Number filled in. In the Models Property 
Dialog Box Sheet Number Field edit the Drawing Number Prefix as needed for the specific 
disciple. 

6. Click on the Index of Drawing Table and fill in the needed information. Edit the Table Title 
Header with the corresponding Subset Number and Discipline Name. Edit the Index Prefix to 
match the Drawing Number Prefix if it was changed in the Title Block (step 3). 

 
Figure 35 - Discipline Subset Cover Sheet / Index of Drawings 

7. Insert Rows as needed. 

 
Figure 36 – Insert Rows 



VOLUME 13 – Contract Plans Production 

35 
 

8. The Signature Block is located in the bottom right of the sheet and will be signed in the PDF. 
 

 
Figure 37 -  State Design Cover Sheet Seed Signature Block 

 

    
Figure 38 - Consultant Cover Sheet Seed Signature Block 
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Section 3 - Creating Detail Sheets 
Introduction to Productivity Tools 
Option 1 – Auxiliary Scale Detailing 
Multiple details draw directly on a sheet at different scales. 
Use this workflow to have several details drawn directly on a sheet and have each one drawn 
using its own scale. This will allow users to work in one model when detailing and not have to 
switch out and manage multiple models. 
Users will work in a 2D Sheet Model at full scale and select Auxiliary Scales to work on different 
details. Users will dimension and annotate each detail in the Sheet Model. 
Option 2 – Base Graphics Detailing 
Reusing base graphics on multiple details at different scales. 
Use this workflow to have base graphics re-used in multiple details. This method will have users 
draw base graphics in a Design Model, then reference those same graphics into a sheet model for 
different details. The details in the design model can be referenced into the sheet several times 
using different scales as needed. Users will dimension and annotate each detail in the Sheet 
Model. 

  
The productivity tools can be found on the CTDOT Workflow, on the Alt Detailing Tab. 
The Scaled Dimension section will be used when dimensioning each detail. Pull down menus are 
provided for dimensions using both 120 and 080 text sizes. Each pull down menu has tools that will 
set the needed Auxiliary Scale. There are also tools for Call Outs, Notes, Detail Titles and Scales in 
the Annotation section. 

 
Figure 39 – Alt Detailing 

What does each Aux Scale tool trigger? 
Selecting the Scaled Dimension section 120 Text Size/Aux Scale 3/4” = 1’, changes the ACS Scale 
and Element Template, which has an assigned Text Style, Dimension Style and Level. 
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Figure 40 –Detailing 

 
Figure 41 - Detailing 
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3.1 Startup 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

3.2 Auxiliary Scale Detailing Workflow 

1. Create a file using the corresponding seed file. 

2. Note: If there is already a dgn file created for other detail sheets, users should import the 
Sheet Model from one of the seed files below. There are ACS Scales in these models that will 
be needed when using the productivity tools. 

OpenRoads 
…\Organization\Seed\Road\Seed2D - CT RoadSheet-Alt Detailing.dgn 
OpenRail 
…\Organization\Seed\Rail\Seed2D - CT RoadSheet-Alt Detailing.dgn 

OpenBuildings 
…\Organization\Seed\Buildings\Seed2D - CT BuildingsSheet-Alt Detailing.dgn  

OpenBridge 
…\Organization\Seed\Bridge\Seed2D - CT BridgeSheet-Alt Detailing.dgn 

3. Click on the Models icon and open the Sheet Model. Ensure that the ACS Plane Lock is 
enabled, on the Models Dialog select and highlight the Sheet Model and in 
the Properties dialog box make sure Locks\ACS Plane is set to True. 
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Figure 42 – Alt Detailing 

4. Select the CTDOT workflow and click on the Alt Detailing tab. 

5. In the Annotation section click on the Detail Title pull down and select the desired scale for 
the detail. Place the Cell inside the sheet border and edit the Title text as needed. 

6. In the Scaled Dimension section select either 120 Text Size or 080 Text Size, then proceed to 
pick your Aux Scale tool. 

7. Inside the sheet draw the detail above the title using the Placement Tools. 

8. To Dimension be sure to pick the corresponding Aux Scale tool again just to be sure the 
settings did not get changed while drawing the detail. 

9. Use the Call Out and Notes tools to finish annotating. 

10. Repeat 3-9 selecting a different scale, notice the dimensions work properly as they are 
based of the ACS Scale. 

11. Save Settings. 

  



VOLUME 13 – Contract Plans Production 

40 
 

3.3 Base Model Detailing Workflow 

1. In the same file created in the Auxiliary Scale Detailing Workflow open the Design Model. 
Proceed to draw the line work for the Detail at full scale. 

2. When the line work is complete open the Sheet Model. Click on the Models icon and open 
the Sheet Model. Ensure that the ACS Plane Lock is enabled, on the Models Dialog select and 
highlight the Sheet Model and in the Properties dialog box make sure Locks\ACS Plane is 
set to True. 

 
Figure 43 ASC Plane Lock 
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3. Click on the Annotate tab, in the Detailing section select to the Detailing Symbols 
Styles dialog box. Right click on the Center Style option and select Activate. 

 
Figure 44 – Activate Detailing Symbol Style 

4. Reference in the Design Model using the 
following settings: 

• Model: Select the Design Model 
• Orientation: Standard Views > Top 
• Detail Scale: Set as needed 
• Name: Name the Detail 

5. Select OK and place the reference inside 
the Sheet Border. 

6. Clip the Reference file Boundary as 
needed. 

7. To Dimension access the Scaled 
Dimension section, select the 
desired Text Size pull down and pick 
the Aux Full Scale tool. 

8. Use the Call Out and Notes tools to finish 
annotating.  

Figure 45 - Referencing 



VOLUME 13 – Contract Plans Production 

42 
 

9. Open the References dialog box, click on the Design Model Reference File make the option 
for Treat Attachment as Element for Manipulation active. 

 
Figure 46 - Referencing 

10. Use the Section tool to select all the elements of the Detail (Reference File, Annotation and 
Dimension) and move the Detail inside the sheet border as needed. 

11. Repeat steps 4-9 using a different Scale, notice the dimensions work properly as they are 
based of the Design Model. 

12. Save Settings. 
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Section 4  – Roadway Sheets 

4.1 Overview 
All files for contract plans, profiles and cross sections will reside in the Contract_Plans folder 
under the disciplines folder; example: project folder/Highways/Contract_Plans. 

4.1.1 Named Boundaries 

OpenRoads designer uses MicroStation Named Boundaries to define plan, profile, and 
cross section clipping areas. The Named Boundaries tools will create Drawing and Sheet 
models needed for plan, profiles and cross section contract sheets. Sheets are generated in 
their own design file. Files can be created using seeds found in the CTDOT DDE 
Configuration. 

Sheets are clipped using Named Boundary tools from the OpenRoads Modeling 
workflow on the Drawing Production tab. 

The top of the dialog contains several icons to select the type of named boundary that you 
wish to place. 

 Civil Plan  

 Civil Profile 

 Civil Cross Section 

 Civil Cross Section 2 Points 

 By 2 Points 

 By Polygon 
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CTDOT has configured sheet clipping options for plan, profile, and cross section sheets with 
common scale options. These configurations are stored in DGN Libraries and will appear in 
the Drawing Seed drop down menus, see below. 

       

 
Figure 47 
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A sheet design file is created to house the named boundaries as well as the completed 
sheets. The various base model design files required to assemble the sheets are attached 
as reference files to the Design Model in the sheet design file. The named boundaries are 
placed in the design model relative to a selected alignment, profile, or 3D model for cross 
sections. 

 
Figure 48 

4.1.2 Plan and Profiles 

Examples showing four named boundaries placed for the plan and profile sheet production 
are shown below.  

 
Figure 49  
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Tip: When the file containing the existing ground terrain is attached, setting the terrain 
active is necessary to display the existing ground profile on the sheets. When the terrain 
model is set active, a 3D model is created in the active file and attached as a reference to 
the plan view. The 3D model is typically not needed for plan and profile sheets and the 
display should normally be turned off in the when the sheets are generated, the software 
creates a MicroStation drawing model for each named boundary, plan, profile, or cross 
section. An example of the drawing model for a plan view named boundary is shown 
below.  

 
Figure 50 

The drawing models are referenced to a sheet model with a sheet border to assemble the 
completed sheets for PDF generation as shown in the example below.  
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Figure 51  

The sheet model is intended for PDF generation. Most annotations should be placed in the 
various drawing models, not in the sheet models. 

  

4.1.3 Cross Sections 

Cross-section sheets are generated in their own design file. Within this file, OpenRoads 
designer uses MicroStation Named Boundaries to define cross-section clipping locations. 
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Before generating the named boundaries, a design file is created to house the cross-
section sheets. The various base model design files required to assemble the cross sections 
are attached as reference files to the Design Model in the design file. The 3D model must be 
displayed. The cross section is cut from the 3D model. In the example below, the geometry, 
survey, and corridor model base models are attached to the plan view with the 3D model 
displayed. The named boundaries are placed in the 3D model relative to a selected 
alignment like the example below. 

 
Figure 52 

When the sheets are generated, the software creates a MicroStation drawing model for 
each named boundary. An example of the drawing model for a cross-section is shown 
below.  

 
Figure 53 

  

The drawing models are referenced to a sheet model with a sheet border to assemble the 
completed cross-section as shown in the example below.  
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Figure 54  

The sheet model is intended for PDF generation. Most annotations should be placed in the 
various drawing models, not in the sheet models. 
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4.2 Startup  

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through CAD Accounting or the Customized Icon. 

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 
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4.3 Typical Section Sheets 

1. Create a DGN file from the civil sheet seed and save it to the Contract_Plans folder. 

…CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadSheet.dgn 

2. Activate the CTDOT Workflow. 

 
Figure 55 

3. In the 2D Sheet Model change the Annotation Scale to Full Size 1 = 1. 

 
Figure 56 

4. Edit the Sheet Name as needed. 

 
Figure 57 

5. Place the CTDOT Contract Border Cell using the tool supplied in the Ribbon. 

 
Figure 58 
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6. In the Properties Dialog Box Edit the Border information. This will update the Border 
Description: Drawing Title. 
Sheet Number: Drawing No. 

7. A Design Model will need to be created to hold the Typical Sections and/or Detail graphics. 
On the Models Dialog Box select the New File Icon, in the Create Model Dialog Box select the 
following: 

Type: Design From Seed. 
Annotation Scale: Full Size 1 = 1. 
Enter a Name for the Model and Click OK. 

 
Figure 59 

8. To automate the drafting process Typical Sections can be displayed from the Roadway 
Template Library. In the Design model, use the Search command by Typing Display 
Template. The tool will appear, follow the prompts to place the Desired Roadway Template 
(if your Roadway Template Library is blank, see procedures in Volume 3.2. The Template will 
place using the active attributes, users will need to edit as necessary to get the desired look 
and layout. 

 
Figure 60 

9. On the bottom left locate the Model Selector and change back to the Sheet Model. 
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Figure 61 

10. Make sure the Models Dialog Box is opened. To reference drag the Design Model from the 
Model Dialog Box into a View in the Sheet Model. In the Attach Source files Dialog Box select 
the Attachment Method: Top. 

 
Figure 62 

11. Follow the prompts for reference placement, it will come in very large (at full size). 

12. In the References Dialog Box change the Detail Scale as needed and move the Reference 
File to the desired location on the sheet. 
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Figure 63 

13. Dimension and Annotate as needed using the CTDOT Annotation and Dimensioning Tools. 

 
Figure 64 

14. Add General Notes and a Legend. There is a table seed for the General Notes available in 
the Table Tool. In Search type Place Table, on the Place Table Dialog Box select 
Seed: General Notes and proceed to place the table. 
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Figure 65 

15. Create another Design Model and place the Line Work for another Detail. 

16. Change back to the Sheet Model. 

17. Drag the new Design Model into the Sheet Model using the Attachment Method: Top. 

18. In the References Dialog Box edit the Detail Scale as needed (for demonstration purposes) 
change it to something other than what was used in step 12. 

19. Move the Detail to the desired location on the sheet. 

20. Dimension and Annotate as needed. 
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21. Notice the Text is the same size in both the Typical Section and Detail even though they are 
placed at two different detail scales. 

 
Figure 66 
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22. Use the Measure Distance tool to measure elements in each detail, notice that it will 
measure at paper size. In the Reference Dialog Box Activate on a Reference and measure, 
notice you now get the true size. When dimensioning a reference the results will also yield 
the true element size. 

 
Figure 67 

23. To return to editing the Sheet Deactivate the Reference. 
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4.4 Plan and Profile Sheets 

4.4.1 Create Plan Sheet 

1. Create a design model that will be used to create the plan and profile sheets for the 
project.Browse to the Contract_Plans folder to create a new 2D design file using the file 
naming convention as described in the Volume 16 Appendix 4 - File Naming  

example: HW_CP_5678_5678_PlanPro_SR_14.dgn  

using the correct seed file:  

…CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 

2. Reference in the needed base model files, they reside in the Highways/Base_Models 
folder within the project folder.  The models will be referenced using No Nesting.  This will 
include the Alignment Models, the Corridor Models, Drainage Models, the 2D Layout 
Models, and the Existing Terrain, ROW and Annotation Models. 

4. Set up the display views to show Default view and profile view. Set the terrain to active 
and Save Settings. Turn off  

 
Figure 68 

5. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 
Boundary. A named boundary is a closed element that has a name associated with 
it. Previously you could create named fences from fences, clip volumes and clipped 
masks. 
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Figure 69 

6. Select the Civil Plan mode. Set Drawing Seed to 40 Scale Contract Plan Sheet.  Set the 
Detail Scale to 1"=40'. The Set Name will be set to Plan 1. 

TIP: Including the number 1 at the end of the name keeps the names of the named 
boundaries and sheets more uniform because the number is included in the first name. 
Otherwise, the incremented numbering begins with the second name, example: Plan, 
Plan 1, Plan 2. 

 
Figure 70 
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7. Set the Group to (New). Set the Group Name to match alignment name, usually the 
Route Number or Street name (This is the lower name field which defines the name of 
the named boundary group.) Example: SR 14 (for State Route 14). Length (length of 
alignment on one sheet), Left Offset and Right Offset (offset from the alignment), 
Overlap should be set to 0 (a sheet overlaps the other), and Boundary Chords have 
preset values. 

8. Enable the Create Drawing option so that the sheets are created as soon as the named 
boundaries are created. Enable the Show Dialog option. This dialog is used to override 
settings defined by the Drawing Seed if needed. 

9. In the 2D view (default plan view), select the alignment along which the plan named 
boundaries will be created. The command line (lower left corner) will read: Place Named 
Boundary Civil Plan > Identify Path Element. With the cursor select the alignment.  

10. 1Select the desired Start Location. Follow the prompts.C ommand Line: Place Named 
Boundary Civil Plan > Accept/Reject. Identify Path start point to place 
boundary. Follow the prompts.    

TIP: Add extra to the left of the start of your Stationing, example: Beginning Station is 
100+00, at Start Location type in 99+00, this will move the named boundary to the left of 
the start of alignment. Bring your cursor back into the dialog box, enter the Start Station, 
click the Tab button, back in the view left click to Accept.  

11. Next select the Stop Location. Command Line: Place Named Boundary Civil Plan > 
Identify Path end point to place boundary. The named boundaries are displayed 
interactively as the cursor moves. Accept the endpoint location for the named 
boundary. Command Line: Place Named Boundary Civil Plan > Accept/Reject. 
Datapoint point in Plan View to place boundary. Identify Path end point to place 
boundary.  
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12. The Create Drawing dialog box will appear. Ensure the Mode: is set to Plan, Name: 
should be populated with the Plan 
1 from Place Named Boundary Civil 
Plan tool. In the Drawing Model 
portion of the dialog set the 
annotation scale to 1” = 40’. In 
Sheet Model portion of the dialog, 
set the Detail Scale to 1” = 40’.  

13. Enable the Add to Sheet 
Index option. This option will be 
discussed later in this 
module. Enable the Open 
Model option. 

14. Click OK to create the 
sheets. Follow the prompts in the 
lower left corner left click to define 
the named boundaries. Multiple 
left clicks may be required. 

Figure 71 
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15. In the view group dialog, you can now see the newly created drawing models and sheet 
models. 

 
Figure 72 
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4.4.2 Create Profile Sheet 

1. Open the Plan and Profile Design Model and display the profile view. If not already open. 

TIP: If you saved settings after setting up your views (step 2 from create plan sheet 
section) change the active view group to Multi-Model Views.  

 
Figure 73 

2. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 
Boundary. 

3. Select the Civil Profile mode. Set the dialog fields as follows: 
• Drawing Seed > 40 Scale Contract Profile Sheet 
• Detail Scale > 1"=40' 
• Name > Profile 1 (This is the top name field which defines the name of the named 

boundary) 
• Method > From Plan Group 

4. The From Plan Group method matches the profile named boundaries to the plan 
named boundaries. The Station Limits method is used to defined profile named 
boundaries that are not matched to plan boundaries such as for profile only sheets, 
example: profile sheet for a local road. 
• Plan Group > Choose the desired Plan Group if there are multiples in this file. This is 

the name of the plan group that contains the plan named boundaries that will also 
define the profile named boundary locations, example: as named Plan sheets: SR 14 
or State Route 14. 

• Group > (New) 
• Name > Route Number or Street name, example: SR 14 or State Route 14. 
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• This is the lower name field which defines the name of the named boundary group 
for profiles. This is the same group name we used for the plan portion, but they are 
two different groups, one associated with Plan, the other associated with Profile. More 
on this later in this module. 

• Vertical Exaggeration > 10 
• Available Profile Height, Top Clearance (toggled on), Bottom Clearance (toggled on), 

Elevation Datum Spacing, Station Datum Spacing and Profile Shifts are set by the 
drawing seed. 

• Make sure all are toggled on. 
• Use Terrains 
• Use Active Vertical 
• Create Drawing 
• Show Dialog Box 

 
Figure 74 
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5. Follow the prompts in the lower left corner left, Command Line: Place Named Boundary 
Civil Profile > Identify Profile View click in the Profile View to define the named 
boundaries. More than one click is required. 

6. The Create Drawing dialog box will appear. Change the Mode to Profile and the Name 
to Profile 1 (or short Pro 1). Everything else is preset for you.  

7. Toggle on: Add To Sheet Index and Open Model. 

8. Click OK to create the sheets. Follow the prompts in the lower left corner left click to 
define the named boundaries. Multiple left clicks may be required. 

 
Figure 75 
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4.4.3 Review Plan and Profile Sheets 

There are several ways to review individual sheets. Click on the View Tab > Within the View 
Groups tools set you can select any of the sheets. The same tool is also available in 
the Manage View Groups toolbox if docked on the bottom (it usually is). 

 
Figure 76 

1. Select the View Group tool to view the sheets. Each sheet has a Drawing Model and a 
Sheet Model. 

The Drawing Model is always 2D, is a subset of a 2D or 3D design model and is a direct 
reference of the named boundary area, it is geospatially correct.  The Drawing Model is 
used to apply annotations, dimensions and callouts to a design, examples: call outs for 
items such as slope limits and catch basins or dimensions for guiderail offsets. The 
Drawing Model is then referenced into the Sheet Model.  

The Sheet Model is always 2D, serves as an electronic drawing sheet (printed sheet), 
typically has drawing and design model references that are scaled and positioned to 
create a printable drawing. 

Open and review the Sheet Model for Plan 1 by selecting Plan 1 [Sheet] Views and then 
select Apply. 

TIP: You can also double-click on any model in the list to open it as well. 
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2. The Sheet Model for Plan 1 will open. Notice the border cell is placed at 0,0 axis, the 
named boundary shape and all design models are referenced. The project number, 
description and town name(s) will be automatically populated from the Project, the 
Drawing Title will be populated with the text entered in the Model Description Field. 

 
Figure 77 

3. Open and review the Drawing Model for Plan 1 by selecting Plan 1 Views from the list and 
then selecting Apply. 

The Drawing Model for Plan 1 will open. Notice the Named Boundary shape is referenced, 
the Match Mark line and call out has been added to the Drawing Model as well and the 
model is geospatially correct. Plan view annotation should be done in the drawing 
model. 

 
Figure 78  
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4. Review the remaining Sheet Models by using the same steps described above. Become 
familiar how to navigate between the various drawing and sheet models. 

 
Figure 79 

4.4.4 Review Named Boundaries 

1. Select the Multi-Model view again. 

2. Open the Drawing Production > Named Boundaries > Named Boundaries dialog. 

 
Figure 80 

3. In the Named Boundaries box, expand Plan Groups.There is a plan group for the Plan 
Sheets named during creation, example: SR 14. The name of the group and the individual 
named boundaries come from the values defined on the Place Named Boundary 
dialog. Expanding the Linked Profile Groups, shows a linkage to the profile group: 
example SR 14, that is also named as the plan group. 

4. By clicking on the individual plan, the named boundary is highlighted in view 1. 

5. Expand Profile Groups.There is a profile group to see the individual profile named 
boundaries for the Profile Sheets named during creation, example: SR 14. 
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Figure 81 
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4.4.5 Adjust Sheet Layout 
1. Final adjustments to sheet layouts can be made in the reference attachments. 
2. Use the View Group tool to select a Plan [Sheet] Views model, example: Plan 2 [Sheet] 

Views. 

 
Figure 82 

3. Select Home > Primary > Attach Tools > References.In the References dialog, select the 
first attachment, this is the Plan Drawing Model, example: (Logical) Plan 2-1, 
HW_CP_5678_5678_PlanPro_SR_14. 

 
Figure 83 
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4. Click on the ‘Move Reference’ command to activate, then click on the Named Boundary, 
this will activate the named boundary with all references (should be highlighted) and 
are “attached” to the cursor, move all for a better fit within the sheet outline. 

 
Figure 84 

5. Left click to accept the new reference location. 

Remember, sheets are references of the respective plan, profile, or cross section space. 
Any elements that are visible in the source drawing will automatically appear on the 
sheets. 
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4.4.6 Adjusting Profile Named Boundaries 

If necessary, the vertical position of a profile named boundary can be adjusted.Open the 
Multi-Model Views. 

1. Select Drawing Production > Named Boundaries > Named Boundary > Adjust Profile 
Named Boundary. 

 
Figure 85 

2. Left click in the profile view (example: View 2). 

3. Left click on one of the profile named boundaries. The name boundary moves vertically 
with the cursor allowing you to adjust the exact position of the boundary.  Notice that the 
boundary moves in increments defined by the Elevation; Datum Spacing, in this example 
10’. The Elevation Datum Spacing was one of the parameters that could be set when the 
named boundaries were created. 

 
Figure 86 
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4.4.7 Deleting Sheets 
Sometimes it is necessary to delete sheets. There are multiple parts to a sheet. 

• The named boundary that defines the boundaries of what is shown in the plan or 
profile. 

• The Drawing Models for annotation and dimensioning. 
• The Sheet Models with the electronic drawing sheets. 

To completely delete the sheet these all need to be deleted. 
TIP: When it becomes necessary to delete sheets depending on the number of sheets for 
your project, it may be easier to create a new design model and start over and only delete 
from the sheet index. This is because usually the plan named boundary is linked to the 
profile named boundary and profiles will need to be deleted also.  

 
Figure 87 

1. Select Home > Primary > Models. Select all of the Drawing and Sheet models for the plan 
and profile views; example Plan 1 and 2 [Sheet] views and Plan 1 and 2, Profile 1 and 2 
[Sheet] views and Profile 1 and 2. Click Delete Model(s). NOTICE: The sheet models are 
also deleted from the sheet index if necessary. Close the Models dialog. 
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Figure 88 

 
Figure 89 

2. Delete the Named Boundaries for the Plan Sheets and Profile Sheets. Open the Drawing 
Production > Named Boundaries Named Boundaries dialog.  
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Figure 90 

3. Expand the Plan and Profile Groups sections.Select the Plan Group, example SR 14. 
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Figure 91 

4. An Alert appears confirming the Named Boundaries and their associated saved views 
will be deleted.Click on Yes.Every boundary is deleted. 
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Figure 92 
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4.5 Create Blown Up Detail 
This video demonstrates how to place a 20 Scale Detail on an existing 40 Scale Sheet.  

 

 
Figure 93 

4.6 Plan Annotation 
The OpenRoads Designer includes the MicroStation Place Label tool which can read civil object 
data such as curve information for arcs, alignment names, bearings, stations, northing and 
easting, and offsets. Labels are associated with elements and can update and move as the 
reference element changes. Reference elements can be located in the active file or in a 
reference. The Place Label tool is also used for call outs of roadway items. 

There are four terms you should become familiar with when placing and editing labels. 

• Text Style = format of text such as font, font size, spacing, justification etc. 

https://portal.ct.gov/-/media/dot/aec/cad-connect-dde-guide/videos/blown-up-detail.mp4


VOLUME 13 – Contract Plans Production 

79 
 

• Dimension Style = format of dimensions such as terminator arrow, leader lines, text 
orientation, symbology (color, line style and weight of dimension & extension lines and 
terminators). 

• Text Favorite = Intelligent reusable label that can be made up of text and fields. 
• Field = A link or pointer to object information. This could be civil object information such 

as the delta of a curve, coordinates of a curve PI, name of an alignment, station values 
or general MicroStation information such as level name, color, weight. 

 
Figure 94 

Labels can be placed for plan, profile, and cross-sections objects.  
• Plan view labels can be placed in Design or Drawing models, but not Sheet 

models. 

• Labels that need to be rotated to the sheet, should be created in the Drawing 
model. 

• General labels that are not sheet specific and whose rotation does not matter 
can be placed in a Design model and referenced to all sheets, example: 
horizontal alignment stationing and curve data. 

• Profile and cross section labels must be placed in Drawing models. 

There are three icons along the bottom of the Place Note or Place Label toolbox that 
define how the label behaves when the drawing scale is changed or when the 
referenced element changes. 

a. Annotation Lock - Labels created with this option enabled will scale when the 
Annotation Scale is adjusted. 
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b. Association to Element - Labels created with this option enabled but with the 
Relative Association to Element option disabled will remain at their placement 
location when the reference element changes. Only the leader line moves. 

c. Relative Association to Element - Labels created with this option enabled will 
remain at their relative location to the reference element when that reference 
element changes. 

 
Figure 95 

Labels created in OpenRoads have three parts (Leader, Text, and Anchor Point). Labels created 
in MicroStation only have the first two parts. 

• Leader - Optional line and arrow connecting between the Text and the Anchor Point. 
• Text - The label content which is made up of text, text fields, and graphics. 
• Anchor Point - The point that is used to compute values in the fields. 

4.6.1 Label - Horizontal Alignment 
The horizontal Alignment should have stationing, PC's, PI's, PT's, curve data and bearings. 
This has been automated, the labeling/annotation will be in the design file (alignment dgn-
file) and is usually done after the alignment is created. This annotation will be placed in the 
Alignment Base Model with the Centerline and Base Lines. 
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4.6.2 Label – Profile (Vertical Alignment) 
The Profile (vertical alignment) annotation has been automated to show: 

• Stationing and Elevations at the grid marks 
• Stations and Elevations for PVC’s, PVI’s and PVT’s 
• Length of vertical curves with K-factor and Stopping Sight Distance 
• Slope of tangent sections  

The annotation will be in the profile drawing models (example: Profile 1 views and Profile 2 
views for the plan and profile design file HW_CP_5678_5678_PlanPro_SR_14.dgn). 

 
Figure 96 
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4.6.3 CTDOT Annotation Tools 
The CT_CONNECT_DDE workspace has been set-up to ease the annotation for plan sheets, 
adjustments and additions are added periodically.  Select the CTDOT workflow and click the 
CTDOT Tab. Here are tools set-up for each discipline and for various subject matters, here 
we will discuss the annotation tools.  

 
Figure 97 

These annotation tools have been set-up with appropriate attributes (level, color, line style, 
text style, dimension style) these should not be changed by the user. 

 
Figure 98 
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4.6.4 Label the Beginning of Project, End of Project, and Limit of Construction 

1. Select the Plan Views (example Plan 1 Views) – Drawing Model. Select the CTDOT 
workflow and the CTDOT tab. 

2. Click on the Begin Project Limits tool. The Place Note toolbox opens, and the Text Editor 
box should open. In the editor type in the project number, F.A.P. number, centerline 
station, Northing and easting coordinates.   

Example: 
BEGIN PROJECT NO. 5678-5678 
F.A.P. NO. NH78(123) 
CL STA. 100+40.00 
N 671 403.048 
E 993 511.112 

3. Follow the prompts. Place Note > Define start point > snap to the beginning, associate 
point > snap to the next point, > Define NextPoint, or <Reset> to complete.  Place the 
leader and text to fit within the sheet. 

 
Figure 99 
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4. Select Profile Views (example: Profile 1 Views) and repeat the previous steps to label the 
beginning and end of the project. 
Example:     
BEGIN PROJECT NO. 5678-5678 
F.A.P. NO. NH78(123) 
CL STA. 100+40.00 
N 671 403.048 
E 993 511.112 

 
Figure 100 
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4.6.5 Label – Place Call Outs 
1. Select the Plan Views (example Plan 1 Views) – Drawing Model.Select the CTDOT 

workflow and the CTDOT tab.Click on the Call Out tool. 
2. Click on the Label (Weight 2) tool or anyone of the other Label tools: Label Small 

(Weight 2) Label (Weight 0) or Label Small (Weight 0). The Place Note toolbox opens, 
and the Text Editor box should open. In the editor type in the label for the item. 

3. Example: “APPROX. SLOPE LIMITS”. The difference of the Weight 2 or 0 is the line weight of 
the leader line. The weight is chosen according to the complexity of the call outs. 

4. Follow the prompts. Place Note > Define start point > snap to the beginning, associate 
point > snap to the next point, > Define NextPoint, or <Reset> to complete. Place the 
leader and text to fit within the sheet. 

 
Figure 101 
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Figure 102 

4.6.6 Notes 
Notes should generally be placed in the sheet model. Notes are used to convey information 
such as right of way, general construction notes, drainage notes and construction 
sequencing. There are several Note tools available. 

 
Figure 103 

Title - used for the title of a detail blow up or as the label for construction sequences on one 
sheet. 

General Notes, General Notes Small and General Notes Bold - are used for notes 
pertaining to the project, example: All highway markers to be protected during construction. 

Existing Text - is for an existing item to be labeled, such as a mailbox to remain. 
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Match Mark Line and Match Mark - are used to mark and annotate the match mark 
between two sheets, this is automated when using the Plan and Profile Production tool. 

Detail Blow Up - sets the attributes for the blow-up circle or box. 

Place Table tool - is used to place a table for the General Notes. It is formatted and can be 
filled in; for a more detailed description using tables see Bentley Help - Place Table. 

 
Figure 104 

1. Select the Place Table command.  In the Place Table toolbox select the first icon.  

2. Click on Seed: find the table for General Notes, select how many rows and columns are 
needed (this can be edited later if needed). Now the table will be visible on the cursor, 
place the table on the sheet as needed. 

 
Figure 105 
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3. To add/fill in the table select the Annotate tab and choose the Edit 
Text tool. NOTE: Avoid using the Element Selection tool to edit the table as this will lock 
up the file. 

TIP: To better view the Text Editor, the User Preferences have been changed in the View 
Optionsthe Black Background -> White. 

 
Figure 106 
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Figure 107 

4.7 Cross-Section Sheets 

4.7.1 Create Cross-Section Sheets 
All files for project contract plans: plans, profiles and cross-sections will reside in the 
Contract_Plans folder under the disciplines folder; example: project 
folder/Highways/Contract_Plans. 

1. Create a design model that will be used to create the cross-section sheets for the 
project. Browse to the Contract_Plans folder to create a new 2D file using the file naming 
convention as described in the Volume 16 Appendix 4 - File Naming  

Example:  
HW_CP_5678_5678_XSC_SR_14.dgn  
created with the Seed2D – CT RoadDesign.dgn seed file 

…CT_Configuration\Organization\Seed\Road\Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 
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2. Reference in the needed base model file, they reside in the Highways/Base_Models 
folder within the project folder as well as the needed existing survey models. The model 
is referenced using No Nesting. 

3. Select the existing terrain boundary and set it active. Then set up the display views to 
show View 1, Default and View 2, Default-3D. Save settings, this will also establish the 
Multi-Model views. 

 
Figure 108 
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4. Select Drawing Production > Named Boundaries > Named Boundary > Place Named 
Boundary. A named boundary is a closed element that has a name associated with it. 

 
5. The Place Named Boundary Civil Plan, Profile or Cross-Sections dialog box 

opens. Select the Civil Cross-Section mode. Set Drawing Seed to 5 Scale Contract XSC 
Sheet, this will also set the Detail Scale to 1" = 5'.  

The drawing seed defines default values and other important parameters required to 
create sheets. Selecting the drawing seed should always be the first step when creating 
named boundaries. The drawing seed has been set-up for the ANSI D size paper 
(34”x22”), and defaults include: 
• Options on Named Boundary for left and right offsets, section intervals, vertical 

exaggeration, and top and bottom clearances between sections (these can be 
changed if needed). 

• Options to Include Control Points, these are usually the PC’s, PI’s, PT’s of the 
horizontal alignment. 

• Options to Include Event Points Only, this will require the user to establish an Event 
Point List (drainage crossings as example). 

 
Figure 109 
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6. Set the Group to (New). Set the Name: to match the alignment name, usually the Route 
Number or Street name (this name field will define the name of the Named Boundary 
Group) Example: SR 14 (for State Route 14). Clicking on the horizontal alignment will also 
populate this name field with the name of the horizontal alignment.  

7. Enable the Create Drawing option, so that the sheets are created as soon as the named 
boundaries are created. Enable the Show Dialog option, this dialog is used to override 
settings defined by the Drawing Seed if needed.  

8. In the 2D view (default plan view), select the alignment along which the named 
boundaries (sheets) will be created. The command line (lower left corner) will 
read: Place Named Boundary Civil Cross-Section > Identify Path Element. With the 
cursor select the horizontal alignment. Now a light blue line should be visible on the 
cursor. This allows the user to pick the start and stop locations of the named boundaries 
for cross-sections. 

9. Select the desired Start Location. Follow the prompts. Command Line: Place Named 
Boundary Civil Cross-Section > Accept/Reject. Identify Path start point to place 
boundary. 

 
Figure 110 

10. Next select the Stop Location. Command Line: Place Named Boundary Civil Cross-
Section > Identify Path end point to place boundary. The named boundaries are 
displayed interactively as the cursor moves. Accept the endpoint location for the named 
boundary. Command Line: Place Named Boundary Civil Cross-Section > 
Accept/Reject. Datapoint point in Plan View to place boundary. Identify Path end 
point to place boundary.   

11. The Create Drawing dialog box will appear. Ensure the Mode: is set to Cross-
Section, Name: here the cross-section boundaries are named > this will name all 
drawing models and defaults to the station, example: 100+40.00, but can be named 
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XSC-1 if desired. In the Drawing Model portion of the dialog set the Annotation 
Scale to 1” = 5’. In Sheet Model portion of the dialog, set the Annotation Scale and 
the Detail Scale to 1” = 5’.  

12. Enable the Add to Sheet Index option. This option will be discussed later in this 
module. Enable the Open Model option. 

 
Figure 111 

13. Click OK to create the sheets. At the bottom of the view windows, a gage will appear 
showing the progress of Sheets Created and then the progress of Drawing Models 
Annotated. When all is completed the last cross-section sheet will be open. 

 
Figure 112 
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4.7.2 Review Cross-Sections 
There are several ways to review individual sheet models or drawing models.  

• Manage View Group dialog 
• Named Boundaries dialog 
• Models dialog 
• Sheet Index 
 

1. Click on the View Tab > Within the View Groups tools set and select any of the sheet 
models or drawing models. The same tool is also available in the Manage View Groups 
toolbox if docked on the bottom (it usually is). Each sheet model has drawing models 
for each section on the sheet model. 

 
Figure 113 

The Drawing Model is always 2D, is a subset of a 2D or 3D design model and is a direct reference of 
the named boundary area. The Drawing Model is used to apply annotations, dimensions and 
callouts to a design, examples: annotation for slopes, Edge of Road or Centerline elevations. The 
Drawing Model is then referenced into the Sheet Model.  

The Sheet Model is always 2D, serves as an electronic drawing sheet (printed sheet), typically has 
drawing model references that are scaled and positioned to create a printable drawing.   

For more information see OpenRoads Designer CONNECT Edition Help Menu. 
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Figure 114 

NOTICE: There is a correlation between the Sheet Index, Manage View Groups, Named Boundaries 
and Models 

 
Figure 115 

2. Open and review a Sheet Model by selecting XX+XX.XX [Sheet] Views (example: 
101+50.00 [Sheet] Views) and then select Apply. 
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TIP: You can also double-click on any model in the list to open it as well. 

The Sheet Model for the sections will open. Notice the border cell is placed at 0,0 axis, the 
named boundary shape and all design models are referenced.  The project number, 
project description and town name(s) will be automatically populated from the 
CONNECTED Project, the Drawing Title will be populated with the text entered in the 
Model Description Field.  

 
Figure 116 

3. Open and review the Drawing Models for cross-section sheet by selecting the drawing 
views for the cross-section sheet (example:  for 101+50.00 [Sheet] Views select 101+50 
Views) and then selecting Apply. (Or double click on the view)  

 
Figure 117 
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The Drawing Model for the cross-section will open. Notice there is only one cross-section in 
the drawing model, it shows a grid with elevation and offsets, it shows the existing terrain 
and proposed design, and has annotation for station, slopes and call outs for Edge Of Road 
and Center Line. Cross-Section annotation should be done in the drawing model.  

Review the remaining Sheet Models by using the same steps described above.  Become 
familiar how to navigate between the various drawing and sheet models. 

4.7.3 Adjust Sheet Layout – Add Single Cross-Section 
Sometimes it becomes necessary to add a cross-section at one particular station that 
does not fall on the interval stations of the cross-section creation, this can be done if 
necessary.  

As an example:  A driveway was not on the original survey (Terrain) and added later.  The 
design model (corridor) was updated to include the driveway, but the cross-section 
drawing models and sheet models do not include this added driveway.  The particular 
cross-section sheet model for the project has room to add the driveway cross-section. 

NOTE: This should only be done if necessary and the drawing models can be adjusted to 
allow for the additional drawing model onto the sheet model.  If more additional cross-
sections are needed, it may be necessary to redo the cross-section plan production and 
add an event point list. 

 
Figure 118 
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Adjustments to the sheet layout are made in the reference attachments.  
1. Use the View Group tool to select the cross-section sheet view (sheet model) to add the 

additional section drawing model, example: 101+50.00 [Sheet] Views. 
2. Select Home > Primary > Attach Tools > References.  In the References dialog there are 

references for each cross-section drawing model, select the drawing model attachment 
for the section that will be moved, example: (Logical) 102+50-1, for the dgn-file: 
HW_CP_5678_5678_XSC_SR_14.dgn, see the dash-dot outline around the cross-
section. 

 
Figure 119 

3. Click on the ‘Move Reference’ command to activate, then click on the Named Boundary 
(cross-section drawing model), this will allow the reference to be moved (should 
be highlighted) and are “attached” to the cursor, move to the desired location within the 
sheet outline. 

TIP:  It helps to activate Accudraw for this command, first deactivate Civil Accudraw if 
active. 

 
Figure 120 
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Figure 121 

4. Left click to accept the new reference location.  Turn of Accudraw, if activated. 

 
Figure 122 
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5. Set the View Group to Multi-Model Views, once more.  Using drawing tools create a line 
across the alignment where the cross-section is to be cut.  Example: centerline of 
driveway at Sta.102+34.00 about the same length as the named boundaries lines of the 
other sections. 

 
Figure 123 

6. Create a single Cross-Section Drawing Model. Select Drawing Production > Named 
Boundaries > Named Boundary > Place Named Boundary. 

7. In the Place Named Boundary Civil Cross-Section dialog, select Civil Cross-Section 2 
Points.  This command will create a cross-section along a path (alignment) from a line 
crossing the alignment.  Set the Drawing Seed to 5 Scale Contract XSC Sheet.  Select 
the Group from the previous groups (example: SR 14).  Check ON the Create 
Drawing option and the Show Dialog option. 
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Figure 124 

8. Follow the prompts: Place Named Boundary Civil Cross-Section 2 Points > Identify Path 
Element (this is the horizontal alignment, example: SR 14); > Enter first point (click on the 
first point of the line, should be to the left of the alignment); > Enter second point (click 
to the end point of the line to the right of the alignment) > Accept/Reject. Data point in 
Plan View to place boundary.  The single cross-section boundary is placed in the 2D 
view and 3D view. 

 
Figure 125 

9. The Create Drawing box comes up, set the following: Mode: Cross-Section; Name: 
automatically fills in (example: 102+34.00); Drawing Seed: 5 Scale Contract XSC 
Sheet; all Scales should be 1” = 5'; Check ON Open Model, but check OFF Add To Sheet 
Index; Click Ok. 
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Figure 126 

10. The new single cross-section sheet will open, with the single cross-section drawing 
model referenced in.  Open the references dialog to review the sheet and drawing 
models, example View 1, 102+34.00 [Sheet] and referenced drawing model 102+34.00. 
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Figure 127 

11. This drawing model must now be referenced into the prepared sheet model.  Open the 
prepared sheet model, example: View 1 101+50.00 [Sheet].  Open the references 
dialog.  Attach the drawing model by referencing into the contract plans cross-section 
file, example: HW_CP_5678_5678_XSC_SR_14.dgn.  Reference Attachment Properties 
settings as follows (should be the same settings as the other cross-section drawing 
models for this sheet):  cross-section drawing models for this sheet): 

• Model: pick the added cross-section (102+34.00) 
• Logical Name: should populate to added cross-section (102+34.00) 
• Orientation: Coincident – Aligned with Master File 
• Detail Scale: 1” = 5” 
• Nested Attachments: Live Nesting 
• Nesting Depth: 99 
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Figure 128 

12. Click Ok.  The drawing model is attached, it may be necessary to move the drawing 
model into the right position. 
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Figure 129 

13. For the drawing model to be shown in the sheet index, refresh the sheet index. 
14. Click on the Models icon to open the dialog.  Here the sheet model for the added cross-

section needs to be deleted.  Select the sheet model (example: 102+34.00 [Sheet]), click 
on the Delete model(s) button. 
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Figure 130 

4.7.4  Deleting Cross-Section Sheets 
Sometimes it is necessary to delete sheets. There are multiple parts to a sheet.   

• The Named Boundary that defines the boundaries of what is shown in the cross-
sections   

• The Drawing Models for annotation and dimensioning   
• The Sheet Models with the electronic drawing sheets – printed sheets    

To completely delete the sheets, these all need to be deleted.  

TIP: When it becomes necessary to delete sheets depending on the number of sheets for 
your project, it may be easier to create a new design model and start over and only delete 
the cross-section sheets from the sheet index.     

1. Select Home > Primary > Models.  Select all of the Drawing and Sheet models for the 
cross-section views; example: 100+40.00 and 100+40.00 [Sheet], 100+50.00 and 
100+50.00 [Sheet], 101+00.00 and 101+00.00 [Sheet], and so on (click on the first model, 
hold down the shift key and scroll to the last model, but leaving Default and Default-
3D).  Click Delete Model(s). An Alert box may open, Click Yes.  Close the Models dialog. 
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Figure 131 

 
Figure 132 

NOTICE: The sheet models are also deleted from the sheet index. 

2. Delete the Named Boundaries for all Cross-Section Sheets.  Open the Drawing 
Production > Named Boundaries Named Boundaries dialog.   

3. Expand the Cross-Section Groups folder.  Click on the Cross-Section group, example: 
SR 14.  In the Default-3D view all cross-section named boundaries should be 
highlighted.  Click on the delete icon. 
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Figure 133 

4. An Alert appears confirming the Named Boundaries and their associated saved views 
will be deleted.  Click on Yes.  Every boundary is deleted, review the Default and Default-
3D views, if boundaries still visible, refresh the view. 
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4.7.5 Place Labels (Annotation) 
As explained previously OpenRoads Designer includes the MicroStation Place Label tool 
which can read civil object data.  Labels are associated with elements and can update and 
move as the reference element changes.  Reference elements can be located in the active 
file or in a reference.  The Place Label tool is used for call-outs. 

There are four terms: Text Style, Dimension Style, Text Favorite and Field; that you should 
become familiar with when placing and editing labels. 

Labels can be placed for plan, profile, and cross-sections objects. 
• Cross-Section labels must be placed in Drawing models. 
• General Notes for cross-sections should be placed in the sheet model. 

Along the bottom of the Place Note or Place Label toolbox are three icons that define how 
the label behaves: Annotation Lock - Association to Element - Relative Association to 
Element 

Labels created in OpenRoads have three parts: Leader, Text, and Anchor Point. Labels 
created in MicroStation only have the first two parts. 

This module will cover some of the labeling tools, but not all.  For more detailed descriptions 
and instructions go to the Bentley ORD Help Menu. 

4.7.6 CTDOT Annotation Tools 
The CT_CONNECT_DDE workspace has been set-up to ease the annotation for cross-
section sheets, adjustments and additions are added periodically to the workspace. 

Select the CTDOT workflow and click the CTDOT Tab.  Here are tools set-up for each 
discipline and for various subject matters. These annotation tools have been set-up with 
appropriate attributes (level, color, line style, text style, dimension style) these should not be 
changed by the user. 

 
Figure 134 

https://docs.bentley.com/LiveContent/web/OpenRoads%20Designer%20CONNECT-v10/en/GUID-1B18BC16-7361-4DA1-BC57-D8A9EEF3F9E7.html
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4.7.7 Labeling and Annotation for Cross-Sections 
For cross-section annotation a lot of automation has been set up for the user.  When 
creating the cross-sections drawing models the following annotation will be placed: 

• Station 
• Breakpoints: Edge Of Road, Shoulder, Elevation (centerline or baseline) 
• Slopes within roadway in % 
• Slopes of cut and fill in H:V 

 
Figure 135 
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4.7.8 Adjust the Existing Ground Dashed Line Display Settings 

It is CTDOT’s standards to show the existing ground display as a dashed green line on the 
cross-section sheets.  There is a setting that needs to be adjusted after the sheets are 
created so the dashed line shows up properly on the Cross-Section Sheets. 

Please Note: This will be done after the Place Named Boundary Civil Cross-Section tool is 
used to cut and create the cross-section sheets. 

1. Open the 3D Model that houses the Cross-Section’s Named Boundaries. 

 
Figure 136 

2. Click on the Element Selection Icon.  In the Element Selection dialog box choose 
the Down Arrow to Show Extended Settings.  Click on the Element Class tab and select 
the Element Class Construction. 

 
Figure 137 
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3. In the Properties dialog box select all the Named Boundaries at once.  Change the Back 
Depth to -.001. 

 
Figure 138 

4. Open several Cross-Sections Sheet Models to view the correction made to the existing 
ground dashed lines.  Below is a screen shot of a pdf showing the before and 
aftereffects of applying the adjustment. 

 
Figure 139 
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Section 5 – Traffic Signal Sheets 

5.1 Create New File 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7. Select the New File icon. In the New dialog box browse to the Traffic/Contract_Plans folder. 

8. The Seed file should be set to Seed2D - CT RoadDesign.dgn. If this is not the case, click on 
the Browse button.  Browse to ...CT_Configuration\Organization\Seed\Road and 
select Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder 
…CT_Configuration\Organization\Seed\GCS\ 

9. In the File name field enter a name for your file using the CTDOT file naming structure. 

Example: TR_CP_1234_1234_Signal_123_123.dgn 

10. Select Save and the new file will open. 

11. If it has been determined the provided survey is in NAD 27/NAVD 29 you will need to re-
project your design file’s Geospatial Header.  
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5.2 Set up the Default Model 

1. Select the CTDOT workflow and click on the Attach tab, in the References Section click 
on Attach Reference. 

• Reference the needed Proposed Base Model dgn files including but not limited to: 
• Signal 
• Signing and Pavement Markings 
• Alignment 
• Highway 
• Drainage 
• Bridge/Structures 
• Illumination 

2. In the Attach Reference Box browse and select the desired file and click Open.  In the 
Reference Attachment Dialog Box choose: 

Model: Most likely it’s “Default” but this could vary depending how the file has been set up. 
Nested Attachments: No Nesting 
Global LineStyle Scale: Master 

3. Click OK finish the Attachment process. 

4. Repeat Steps 1 - 3 for all Proposed Base Models 

5. Select Level Display and turn off or on the desired levels. 

6. Reference the Existing Survey dgn files.  Select the CTDOT workflow and click on 
the Attach tab, in the References Section click on Attach Reference.  

7. In the Attach Reference Box browse the Active Survey Folder and select the desired Existing 
Survey DGN file and click Open.  In the Reference Attachment Dialog Box choose: 

Model: Most likely it’s “Default” but this could vary depending how the file has been set up. 
Nested Attachments: No Nesting 
Global LineStyle Scale: Master 

8. Click OK finish the attachment process. 

9. If the Survey does not line up with the Proposed Design File it is most likely an older Survey 
File that was created with V8i.  Older files will need to be referenced in with certain settings 
to get them to line up in the correct geospatial location.   

Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References Dialog box. 

Turn True Scale off and set the Scale to 1:1.   
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10. Each existing Survey File may need to be referenced twice so some levels can be BOLD and 
other levels SCREENED when creating the PDF plans. 

This can be done by using a specific Logical Name in the Reference Attachment 
Properties: 

BOLD Ground Survey – Will leave all levels in this reference unscreened when the PDF 
is created. 

Common features to be bold: 

• Edge of Road 
• Right of Way Lines 
• Utility Poles and other Above Ground Utilities 
• Sidewalks 
• Catch Basins 
• Rock Walls 
• Fences 

SWW Ground Survey – Will leave all levels in the reference screened with the 
displayed line weights when the PDF is created. 

Common features to be screened: 

• Trees 
• Underground Utilities and Storm Water Pipes 
• Pavement Markings 

11. Select Level Display and turn off or on the desired levels for each referenced Ground 
Survey. 

Note: For signal revisions with no proposed roadway work (realignments or widening) it is 
common in the BOLD Ground Survey reference to turn off all the levels except for the 
existing edge of road, drainage structures, right of way, guiderail, utility poles and related 
text Levels.  These levels will not be screened in this reference file. All the other levels will be 
screened in the SWW reference file.  In this case the SSW Ground Survey reference would 
have the Bold levels off and all the others needed levels displayed on. 

12. Use the Update Sequence dialog box to reorder Reference attachments (appear behind or 
in front of other references) or active file elements In the Reference dialog box, go 
to Settings > Update Sequence.  In the Update Sequence dialog box select the Reference 
(or active file) and then click the up or down arrow buttons to move the file up or down.  The 
order listed is how the updated data appears in the view - lower files/elements appear 
above higher elements. 
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Figure 140 

13. Rotate the view so that the main road is parallel to the screen. On the View Window select 
the Rotate View tool.  Use the 2 Points Method. Follow the prompts to rotate the view. 

 
Figure 141 
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Figure 142 

14. Select Save Settings. 
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5.3 Use Place Name Boundary to Create a Sheet Model 
1. Select the CTDOT workflow and on the Annotate tab locate the Detailing section and select 

the bottom right Styles button. In the Detailing Symbol Styles dialog right click 
on CV_Detail and select Activate. 

 

Figure 143 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

 

Figure 144 
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3. Select the Place Named Boundary tool and the Place Named Boundary Dialog box will 
appear. 

 

4. In the Place Named Boundary dialog box. set the following options in the tool's settings 
window: 

5. Method (icon): By 2 Points 
6. Name: Signal Plan 
7. Mode (icon): Place Single Named Boundary 
8. Create Drawing: Enabled 

 

9. Follow the prompts to place a Named Boundary (Clipping Boundary) around the design. 
Data point first in the lower left and ending in the upper right.  This element can be edited 
later to refine the shape and add additional points. 

10. After accepting the placement of the named boundary the Create Drawing dialog box will 
appear.  Ensure the following options are set: 
• Name: Signal Plan 
• Drawing Seed: Signal Plan 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 
• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: Full Size 1 = 1 
• Drawing Boundary: New 
• Detail Scale: 1”=40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 
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11. Click OK.  The newly created sheet model will open with the Named Boundary referenced 
and centered onto the sheet. 

 

Figure 145 
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5.4  Edit the Title Block 

1. From the Ribbon click on the Models icon and select to open the Sheet Model. 

2. View the Properties of the model. Notice the Sheet Model’s Annotation Scale is Full Size 1 = 1. 

3. In the Properties dialog box edit or fill in the following fields: 

• Description: TRAFFIC SIGNAL CONTROL PLAN 
• Sheet Number: TR-01 

Notice the  Drawing Number in the Title Block will be updated to match the Properties.   

 
Figure 146 

4. Use the Edit Text tool to update the ENTER INTERSECTIO DESCRIPTION and ENTER TOWN 
NAME(S). 
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5. Open the References Dialog box and double click on the file to view the Attachment 
Properties of the reference.  The Drawing Model will be referenced in at a 1” = 40’ Detail 
Scale. 

 
Figure 147 

6. Select Save Settings. 



VOLUME 13 – Contract Plans Production 

123 
 

5.5 Adjust the Named Boundary 

1. From the Ribbon click on the Models icon and select to open the Default Design Model. 

2. On the Ribbon select Home > Selection and make the Element Selection tool active. 

3. Select the Named Boundary shape and adjust by dragging the handles to the desired 
location. 

 
Figure 148 

4. The Insert Vertex or Delete Vertex tools can also be used to edit the shape. 

 
Figure 149 

5. Return to the sheet model by hovering the cursor over the Marker and click the Signal 
Sheet and select the folder Icon (Open Target Tool). This action returns you back to the 
sheet model. Notice that by changing the boundary in the design model, this has 
propagated to the sheet. 

 
Figure 150 
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6. Models can also be opened using the View Group drop down tool located at the bottom left 
of the screen. 

 
Figure 151 

7. Select Save Settings. 

5.6 Move the Name Boundary Inside the Sheet Border 

1. From the Ribbon click on the Models icon and select to open the Sheet Model. 

2. Select the References Icon, in the dialog box right click on the file, select move to re-
position the reference file within the border. 

3. Follow the prompts to execute the move command. 

 
Figure 152 

4. Select Save Settings. 
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5.7 Additional Reference Settings in the Sheet Model 

1. From the Ribbon click on the Models icon and select to open the Sheet Model. 

2. Open the References dialog box and select the reference file, toggle the Scale Line Styles 
By Reference Scale so the lines appear to be the correct size. 

 

Figure 153 

3. If the user would like the Levels that are on and off in the Default Design Model to auto-
match in the Sheet Model select Never in the Display Overrides. 

 

Figure 154 
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5.8 Create Match Marked Areas 

1. If the design is too large for the sheet, Match Marks will be required and additional Named 
Boundaries will need to be created. 

2. Go back into the Design Model and place another Named Boundary adjacent to the original 
named boundary.  This will be the Match Mark.  

3. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

4. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear, set the following options: 

• Method (icon): By 2 Points 
• Name: Signal Plan Match Mark 1 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

5. Follow the prompts to create a named boundary of the around the additional area. 

6. After accepting the placement of the named boundary the Create Drawing dialog will 
appear.  Ensure the following options are set: 

• Name: Signal Plan Match Mark 1 
• Drawing Seed: Signal Plan 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 
• Create Sheet Model: Enabled 
• Sheets: Signal Plan [Sheet] 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled  

7. The existing Sheet Model will open, move the reference to the desired location on the sheet. 

8. Select Save Settings. 
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5.9 Annotate the Drawing Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call-outs and Dimensions should be placed in the Drawing Models.  Placing the Call-
Outs and Dimensions in the Drawing Model will make it easier to move each detail inside 
the Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the Sheet Models. 

1. Open a Drawing Model and use the tools on the CT DOT Ribbon’s, Annotation section to 
place Call Outs. Select Label Small (Weight 0) and follow the prompts for placement. 

 

Figure 155 

2. Any Property of an Element can be targeted for annotation automation by using the Insert 
Field tool. Select the Label Small (Weight 0) tool.  In the Text Editor dialog box select 
the Insert Field icon. 

 

Figure 156 
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3. For Field Type select Element Properties and OK. 

 

Figure 157 

4. Click on the element you would like to annotate, and the Fields Editor will pop up. Select 
the desired field and click OK.  In this example a cell with an Item Type was selected and 
the Item_Description field will be annotated. 

 

Figure 158 
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5. Follow the prompts to place the call out. 

 

Figure 159 

 

Figure 160 

6. Use the Note pull down menu’s, General Note Small tool. In the Text Editor dialog box select 
the Insert Field. 

 

Figure 161 
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7. Click on the element you would like to annotate, and the Fields Editor will pop up. Select 
the desired field and click OK.  In this example a cell with an Item Type was selected and 
the ID_Number field will be annotated. 

 

Figure 162 

8. Follow the prompts to place the note. 

 

Figure 163 
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9. Match Marks are to be placed in the Drawing Model using the tools in the Notes pull down 
menu. 

 

Figure 164 

10. Place Dimensions in the Drawing Model. To place a Dimension, select either 
the Vertical or Horizontal Text Tool on the CTDOT ribbon, then select one of the 
desired Dimensioning tools.  The Element Dimensioning dialog box will appear, select the 
desired Dimension Style and enable Association. 

 

Figure 165 
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11. Note: To correctly dimension elements being referenced from in old survey files it is 
suggested to make copies of the delivered dimension styles and in the Units tab add a 
scale Factor of 480. 

 

Figure 166 



VOLUME 13 – Contract Plans Production 

133 
 

5.10 Annotate the Sheet Model 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call-outs and Dimensions should be placed in the Drawing Models.  Placing the Call-
Outs and Dimensions in the Drawing Model will make it easier to move each detail 
inside the Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the sheet models. 

5.10.1 Detailing Cell Library 

Choose the CTDOT workflow and select the CTDOT tab. In 
the Detailing section select Miscellaneous > Open Signal Detailing.  A cell library will 
open, this cell library contains Tables, Turning Movements and Signal Face Details.  Double 
click to activate the needed cell and follow the prompts for placement. 

 

Figure 167 
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5.10.2 Tables 

1. Several tables have been created and can be used instead of the Cells in the Detailing 
Cell Library. From the Ribbon click on the Models icon and select to open the Sheet 
Model. 

2. On the CTDOT Ribbon select the Annotate Tab and click on the Place Table icon. 

Preconfigured Custom CTDOT Table Seeds are available for placement.  In this exercise 
we will place both empty tables and table populated from a report. 

Empty Tables will come with prepopulated with Title and Header Information and blank 
body cells to be filled out by the user.  Examples: 
• Movement Diagram Top 
• Movement Diagram Bottom 

Tables from Reports will place with all the needed information already filled 
in.  Examples: 
• Mast Arm Information 
• Span Pole Information 

3. On the Place Table dialog box select the Empty Table Icon. Select the SIGNAL – 
Movement Diagram - Top seed and follow the prompts for placement in the upper left-
hand corner of the sheet. 

4. Select the SIGNAL – Movement Diagram – Bottom and snap to the bottom left corner of 
the top movement diagram. 

 

Figure 168 

5. To add information to the table select the Annotate tab and choose Edit 
Text.  Note: Avoid using the Element Selection tool to edit the table as this will lock up 
the file. 
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Figure 169 

6. After the Text and Number entries are complete in the tables, Cells will need to be 
placed on top of the Table.  The Table should be locked before the cells are placed.  To 
lock a table, select the table in the View Window and in the Extended Section of 
the Properties dialog box select Locked. 

 

Figure 170 

7. The Cells needed to complete the Movement Diagram can be accessed choosing 
the CTDOT workflow and selecting the CTDOT tab. In 
the Detailing section select Miscellaneous > Open Signal Detailing.  A cell library will 
open, double click to activate the one of the TURNING MOVEMENT cells and follow the 
prompts for placement. 
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8. On the Place Table dialog box select the From Report Icon. Select the 
desired Seed and Report. Retain Association should be toggled on. 
Selections for Mast Arm and Span Poles: 
Seed                                                                                 Report 
SIGNAL – Mast Arm Information                              MAST ARM INFORMATION 
SIGNAL – Combination Mast Arm Information     COMBINATION MAST ARM INFORMATION 
SIGNAL – Span Pole Information                              SPAN POLE INFORMATION 
SIGNAL – Combination Span Pole Information     COMBINATION SPAN POLE INFORMATION 

9. Select the Browse button next to report. 

 

Figure 171 

10. On the Reports dialog box right click on the desired report and select Save to active 
file.  Now move to the right part of the dialog box and for Model assure that the Default 
Model is selected. Follow the prompts for placement. 

 

Figure 172 
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5.10.3 Notes 

Use the tools on the CTDOT Ribbon’s, Annotation section to place Notes. 

  

Figure 173 
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5.11 Create a Signal Face Detail 

1. Go back into the Design model and Place another Named Boundary, but this time only 
around the Signal Faces. 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

3. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear, set the following options: 

• Method (icon): By 2 Points 
• Name: Signal Faces 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

4. Follow the prompts to create a named boundary around the Signal Faces. 

5. After accepting the placement of the named boundary the Create Drawing dialog will 
appear.  Ensure the following options are set: 

• Name: Sign Face Detail 
• Drawing Seed: Signal Plan 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 20’ 
• Create Sheet Model: Enabled 
• Sheets: Signal Plan [Sheet] 
• Drawing Boundary: New 
• Detail Scale: 1” = 20’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

6. The existing Sheet Model will open, move the reference to the desired location on the sheet. 

7. In the Drawing Model annotate the detail. 

8. Select Save Settings. 
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5.12  Create a Mast Arm Detail 
1. In the Contract Plan DGN file create a new 2D Design Model.  From the Ribbon open 

the Models dialog box. 

 
Figure 174 

2. On the Models dialog box select the Create a new model icon. 

 
Figure 175 

3. In the Create Model dialog box, ensure the following options are set: 
• Type: Design From Seed 
• Seed Model: Seed2D – CT Road.dgn, Default 
• Name: Mast Arm Detail 
• Annotation Scale: 3/16”=1’-0” 
• Propagate: Enable 

4. Click OK. 

 
Figure 176 
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5. In the new model draw the elevation view of the mast arm. Annotate and dimension the 
detail. Note: This detail can be annotated and dimensioned in this same model as it is not a 
Geospatial Base Model. 

6. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

7. Using the Place Named Boundary tool, place a Named Boundary around the detail.  Ensure 
the following options are set: 

• Method (icon): By 2 Points 
• Name: Mast Arm Detail 
• Mode: Place Single Named Boundary 
• Create Drawing: Disabled 

8. Open the Signal Plan Sheet Model.  This can be done using the View Group drop down tool 
located at the bottom left of the screen. Select Signal Plan (Sheet) Views. 

 
Figure 177 
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9. Reference in the Mast Arm Detail.  In the Reference Attachment Properties ensure the 
following options are set: 
• Model: Mast Arm Detail 
• Orientation: Named Boundaries / Mast Arm Detail 
• Detail Scale: 3/16” = 1’-0” 

 
Figure 178 

10. Click OK and follow the prompts for placement in an empty location inside the Sheet 
Border.  Select Save Settings. 
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Section 6 – Signing & Pavement Marking Sheets 

6.1 Create New File 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7. 4. Select the New File icon. In the New dialog box browse to 
the Traffic/Contract_Plans folder. 

8. The Seed file should be set to Seed2D - CT RoadDesign.dgn. If this is not the case, click on 
the Browse button.  Browse to …CT_Configuration\Organization\Seed\Road and 
select Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder 
…CT_Configuration\Organization\Seed\GCS\ 

 

9. In the File name field enter a name for your file using the CTDOT file naming structure. 
Example: TR_CP_1234_1234_SPM.dgn 

10. Select Save and the new file will open. 

11. If it has been determined the provided survey is in NAD 27/NAVD 29 you will need to re-
project your design file’s Geospatial Header   
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6.2 Set up the Default Model 

1. Select the CTDOT workflow and click on the Attach Tab, in the References Section click 
on Attach Reference. 

2. Navigate to the Traffic\Base_Models folder and reference the Master Base Model file. 
Choose the needed Model (most likely its “Default”) and use Live Nesting at a Nesting 
Depth of 2.  

3. Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References Dialog box. 

4. Review the Attachments.  If all the needed files did not propagate to reference with Live 
Nesting in the above step, you will need to reference the files directly. If there is no Existing 
Survey users can attach Raster Images or use a Background Map, these workflows can be 
found in Volume 2 – Module 2 - Attaching Imagery and LiDAR Data. 

5. To reference the Survey navigate to the Active_Survey folder and reference the Survey 
*.dgn file.  Note: Older DGN Files will need to be referenced in with certain settings to get 
them to line up in the correct Geospatial location. 

6. For older reference files turn True Scale off and set the Scale to 1:1. Note: Always do a check 
by clicking on the Survey’s Northing and Easting Grid Marks to compare the files read out.  If 
they do not match you did not properly align the file Geospatially. 

7. Select Level Display and turn off the desired levels. 

8. Rotate the view so that the main road is parallel to the screen. On the View Window select 
the Rotate View tool.  Use the 2 Points Method. Follow the prompts to rotate the view. 

 
Figure 179 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-ebook-Volume-002---Introduction-to-OpenRoads-Designer/Module-2---Attaching-Imagery-and-LiDAR-Data
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Figure 180 

9. Select Save Settings. 
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6.3 Place Named Boundaries 

6.3.1 By 2 Point Method 

Place Named Boundary By 2 Points - used when only one sheet is needed with several 
details on the sheet.  

1. Select the CTDOT workflow and on the Annotate tab locate the Detailing section and 
select the bottom right Styles button. In the Detailing Symbol Styles dialog right click 
on CV_Detail and select Activate. 

  

Figure 181 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section 
and select the Create Clipping Boundary tool. This will update the Element Template to 
the correct level. 

 

Figure 182 
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3. Select the Place Named Boundary tool and the Place Named Boundary Dialog box will 
appear. 

 

Figure 183 

4. In the Place Named Boundary dialog box, set the following options in the tool's settings 
window: 
• Method (icon): By 2 Points 
• Name: Signing and Pavement Marking Plan 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

 

Figure 184 

5. Follow the prompts to place a Named Boundary (Clipping Boundary) around the design. 
Data point first in the lower left and ending in the upper right. This element can be edited 
later to refine the shape and add additional points. 
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6. After accepting the placement of the named boundary, the Create Drawing dialog box 
will appear.  Ensure the following options are set: 
Top Section 

• Name: Signing and Pavement Marking Plan 
• Drawing Seed: 40 Scale Contract Plan Sheet 

Drawing Model Section 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 
• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: Full Size 1" = 40' 
• Drawing Boundary: New 
• Detail Scale: 1”=40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

7. Click OK. 

 

Figure 185  
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6.3.2 Civil Plan Method 

1. Place Named Boundary Civil Plan - used when multiple sheets are needed along a 
corridor.  To use this method a centerline needs to be present in one of the Design 
Models References.  Select the Place Named Boundary tool and the Place Named 
Boundary Dialog box will appear. 

 
Figure 186 

2. In the Place Named Boundary Civil Plan dialog box, ensure the following options are set 
in the tool's settings window: 
• Method (icon): Civil Plan 
• Drawing Seed: 40 Scale Contract Plan 

Sheet 
• Detail Scale: 1”- 40’ 
• Name: Plan 1 
• Group: New 
• Length: 1000 
• Right Offset: -275 
• Left offset: 275 
• Overlap: 0 
• Boundary Cord: 20 
• Create Drawing: Enabled 
• Show Dialog: Enabled 

 

 

 
Figure 187 
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3. Follow the prompts to create a named boundary along the Centerline. 

After accepting the placement of the named boundaries the Create Drawing dialog will 
appear.  Ensure the following options are set: 

Drawing Model Section 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 
• Sheets: New 
• Annotation Scale: Full Size 1" = 40' 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

4. Click OK.  The Drawing Models and Sheet Models will be created. 

 
Figure 188 
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6.4 Edit the Title Block 

1. The newly created sheet model will open with the Named Boundary referenced and 
centered onto the sheet. From the Ribbon open the Models dialog box. 

2. View the Properties of the model. Notice the Sheet Model’s Annotation Scale is Full Size 1 = 1. 

3. In the Properties dialog box edit or fill in the following fields: 

• Description: SIGNING AND PAVEMENT MARKING PLAN 
• Sheet Number: SPM -01 
Notice the Drawing Title and Drawing Number in the Title Block will be updated to match 
the Properties.  The Project Number, Project Description and Town should match the 
WorkSet Properties.    

 
Figure 189 

4. Select Save Settings. 
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6.5 Adjust the Named Boundary 

1. On the Ribbon select Home > Selection and make the Element Selection tool active. 

2. Select the Named Boundary shape and adjust by dragging the handles to the desired 
location. 

 
Figure 190 

3. The Insert Vertex or Delete Vertex tools can also be used to edit the shape. 

 
Figure 191 

4. Return to the sheet model by hovering the cursor over the Marker and click the Sheet and 
select the folder Icon (Open Target Tool). This action returns you back to the sheet model. 
Notice that by changing the boundary in the design model, this has propagated to the 
sheet. 

 
Figure 192 
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5. Models can also be opened using the View Group drop down tool located at the bottom 
left of the screen. 

 
Figure 193 

6. Select Save Settings. 

6.6 Move the Name Boundary inside the Sheet Border 

1. From the Ribbon click on the Models icon and select to open the Sheet Model. 

2. Select the References Icon, in the dialog box right click on the file, select Move to re-
position the reference file within the border.  

3. follow the prompts to execute the move command. 

 
Figure 194 

4. Select Save Settings. 
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6.7 Turn off Levels 
1. Right-press and hold to bring up the contextual menu. From here, select Turn Level Off by 

Element. 

 

2. Issue a Data Point on the Named Boundary, hence turning off the level.  Data Point on other 
elements for levels you would like turned off. 

3. Select Save Settings. 
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6.8 Create Match Marked Areas 

1. If the design is too large for the sheet, Match Marks will be required, and additional Named 
Boundaries will need to be created.  This will be used to include side roads that extend past 
the original clipping boundary or if the main line is slightly too long to fit within the original 
clipping boundary. 

2. Go back into the Design model and place another Named Boundary adjacent to the 
original named boundary.  This will be the Match Mark.  

3. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

4. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear, set the following options: 

• Method (icon): By 2 Points 
• Name: Match Mark 1 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

5. follow the prompts to create a named boundary of the around the additional area. 

6. After accepting the placement of the named boundary the Create Drawing dialog will 
appear.  Ensure the following options are set: 

• Name: Match Mark 1 
• Drawing Seed: 40 Scale Contract Plan Sheet 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 
• Create Sheet Model: Enabled 
• Sheets: Signing and Pavement Marking Plan [Sheet] 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

7. The existing Sheet Model will open, move the reference to the desired location on the sheet. 

8. Select Save Settings. 
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6.9 Create Blown Up Detail 
This video demonstrates how to place a 20 Scale Detail on an existing 40 Scale Sheet.   

 

 

Figure 195 

https://portal.ct.gov/-/media/dot/aec/cad-connect-dde-guide/videos/blown-up-detail.mp4
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6.10 Annotate the Drawing Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models.  Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the Sheet Models. 

1. Open a Drawing Model and use the tools on the CT DOT Ribbon’s, Annotation section to 
place Call Outs. 

 
Figure 196 

2. Match Marks are to be placed in the Drawing Model using the tools in the Notes pull down 
menu. 
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Figure 197 

3. Place Dimensions in the Drawing Model. To place a Dimension, select either 
the Vertical or Horizontal Text Tool on the CTDOT ribbon, then select one of the 
desired Dimensioning tools. The Element Dimensioning dialog box will appear.  Select the 
desired Dimension Style and enable Association and follow the prompts for placement. 

 
Figure 198 
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6.10.1 Annotate a Sign Detail 

In the Drawing Model use the tools on the CT DOT Ribbon’s, Detailing section. 

 
Figure 199 

Use the tools in the Sign Detail pull down to complete the annotation.  This video shows how 
to harvest the Item Type Properties to fill in the Detail Bubbles. 

 
  

 
Figure 200 

https://portal.ct.gov/-/media/dot/aec/cad-connect-dde-guide/videos/sign-detail.mp4
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6.11 Annotate Pavement Markings 
Coming Soon 
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6.12 Annotate the Sheet Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models.  Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the sheet models. 

1. Use the Place Table tool on the CT DOT Ribbon to place preconfigured Tables.  Select 
the General Notes table and follow the prompts for placement. 

 

2. To add information to the table select the Annotate tab and choose Edit Text.  Note: Avoid 
using the Element Selection tool to edit the table as this will lock up the file. 
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3. Use the tools on the CT DOT Ribbon’s, Annotation section to place Notes. 
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Section 7 –  Roadway Illumination Sheets 

7.1 Create New File 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7.  Select the New File icon. In the New dialog box browse to 
the Illumination/Contract_Plans folder. 

8. The Seed file should be set to Seed2D - CT RoadDesign.dgn. If this is not the case, click on 
the Browse button.  Browse to …CT_Configuration\Organization\Seed\Road and 
select Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 

9. In the File name field enter a name for your file using the CTDOT file naming structure. 
Example: IL_CP_1234_1234_Illumination.dgn 

10. Select Save and the new file will open. 

11. If it has been determined the provided survey is in NAD 27/NAVD 29 you will need to re-
project your design file’s Geospatial Header. 
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7.2 Set up the Default Model 

1. Select the CTDOT workflow and click on the Attach Tab, in the References Section click 
on Attach Reference. 

2. Navigate to the Illumination\Base_Models folder and reference the Master Base Model file. 
Choose the needed Model (most likely its “Default”) and use Live Nesting at a Nesting 
Depth of 2.  

3. Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References Dialog box. 

4. Review the Attachments.  If all the needed files did not propagate to reference with Live 
Nesting in the above step, you will need to reference the files directly. If there are no Existing 
Survey users can attach Raster Images or use a Background Map, these workflows can be 
found in Volume 2 – Module 2 - Attaching Imagery and LiDAR Data. 

5. To reference the Survey navigate to the Active_Survey folder and reference the Survey 
*.dgn file.  Note: Older DGN Files will need to be referenced in with certain settings to get 
them to line up in the correct Geospatial location. 

6. For older reference files turn True Scale off and set the Scale to 1:1. Note: Always do a check 
by clicking on the Survey’s Northing and Easting Grid Marks to compare the files read out.  If 
they do not match you did not properly align the file Geospatially. 

7. Select Level Display and turn off the desired levels. 

8. Rotate the view so that the main road is parallel to the screen. On the View Window select 
the Rotate View tool.  Use the 2 Points Method. Follow the prompts to rotate the view. 

 
Figure 201 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-ebook-Volume-002---Introduction-to-OpenRoads-Designer/Module-2---Attaching-Imagery-and-LiDAR-Data
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Figure 202 

9. Select Save Settings. 
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7.3 Place Named Boundaries 

7.3.1 By 2 Point Method 

Place Named Boundary By 2 Points - used when only one sheet is needed with several 
details on the sheet.  

1. Select the CTDOT workflow and on the Annotate tab locate the Detailing section and 
select the bottom right Styles button. In the Detailing Symbol Styles dialog right click 
on CV_Detail and select Activate. 

 
Figure 203 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section 
and select the Create Clipping Boundary tool. This will update the Element Template to 
the correct level. 

 
Figure 204 
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3. Select the Place Named Boundary tool and the Place Named Boundary Dialog box will 
appear. 

 
Figure 205 

4. In the Place Named Boundary dialog box, set the following options in the tool's settings 
window: 
• Method (icon): By 2 Points 
• Name: Illumination Plan 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

 
Figure 206 

5. Follow the prompts to place a Named Boundary (Clipping Boundary) around the design. 
Data point first in the lower left and end in the upper right. This element can be edited 
later to refine the shape and add additional points. 
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6. After accepting the placement of the named boundary the Create Drawing dialog box 
will appear.  Ensure the following options are set: 

Top Section 
• Name: Illumination Plan 
• Drawing Seed: 40 Scale Contract Plan Sheet 

Drawing Model Section 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 
• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: 1" = 40' 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

7. Click OK. 

 

Figure 207 
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7.3.2 Civil Plan Method 

Place Named Boundary Civil Plan - used when multiple sheets are needed along a 
corridor.  To use this method a centerline needs to be present in one of the Design Models 
References.  

1. Select the Place Named Boundary tool and the Place Named Boundary Dialog box will 
appear. 

 

Figure 208 

2. In the Place Named Boundary Civil Plan dialog box, ensure the following options are set 
in the tool's settings window: 

• Method (icon): Civil Plan 
• Drawing Seed: 40 Scale Contract 

Plan Sheet 
• Detail Scale: 1” - 40’ 
• Name: Plan 1 
• Group: New 
• Length: 1000 
• Right Offset: -275 
• Left offset: 275 
• Overlap: 0 
• Boundary Cord: 20 
• Create Drawing: Enabled 
• Show Dialog: Enabled 

 

 

  
 
 
 
 

Figure 209 
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3. Follow the prompts to create a named boundary along the Centerline. 
4. After accepting the placement of the named boundaries the Create Drawing dialog will 

appear.  Ensure the following options are set: 

Drawing Model Section 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 
• Sheets: New 
• Annotation Scale: 1" = 40' 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

5. Click OK.  The Drawing Models and Sheet Models will be created. 

  

Figure 210 
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7.4 Edit the Title Block 

1. The newly created sheet model will open with the Named Boundary referenced and 
centered onto the sheet. From the Ribbon open the Models dialog box. 

2. View the Properties of the model. Notice the Sheet Model’s Annotation Scale is Full Size 1 = 1. 

3. In the Properties dialog box edit or fill in the following fields: 

• Description:  ILLUMINATION PLAN 
• Sheet Number: IL-01 

4. Notice the Drawing Title and Drawing Number in the Title Block will be updated to match 
the Properties.  The Project Number, Project Description and Town should match the 
WorkSet Properties.    

 
Figure 211 

5. Select Save Settings. 

  



VOLUME 13 – Contract Plans Production 

171 
 

7.5 Adjust the Named Boundary 

1. On the Ribbon select Home > Selection and make the Element Selection tool active. 

2. Select the Named Boundary shape and adjust by dragging the handles to the desired 
location. 

 
Figure 212 

3. The Insert Vertex or Delete Vertex tools can also be used to edit the shape. 

 
Figure 213 

4. Return to the sheet model by hovering the cursor over the Marker and click the Signal 
Sheet and select the folder Icon (Open Target Tool). This action returns you back to the 
sheet model. Notice that by changing the boundary in the design model, this has 
propagated to the sheet. 

 
Figure 214 

5. Models can also be opened using the View Group drop down tool located at the bottom left 
of the screen. 
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Figure 215 

6. Select Save Settings. 

  

7.6 Move the Name Boundary inside the Sheet Border 
1. From the Ribbon click on the Models icon and select to open the Sheet Model. 
2. Select the References Icon, in the dialog box right click on the file, select Move to re-

position the reference file within the border. 
3. Follow the prompts to execute the move command. 

 

Figure 216 

4. Select Save Settings. 
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7.7 Turn off Levels 
1. Right-press and hold to bring up the contextual menu. From here, select Turn Level Off by 

Element. 

 

2. Issue a Data Point on the Named Boundary, hence turning off the level.  Data Point on other 
elements for levels you would like turned off. 

3. Select Save Settings. 
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7.8 Create Match Marked Areas 

If the design is too large for the sheet, Match Marks will be required, and additional Named 
Boundaries will need to be created.  This will be used to include side roads that extend past the 
original clipping boundary or if the main line is slightly too long to fit within the original clipping 
boundary. 

1. Go back into the Design model and place another Named Boundary adjacent to the original 
named boundary.  This will be the Match Mark.  

2. Select the CTDOT workflow and in the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the correct 
level. 

3. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear, set the following options: 

• Method (icon): By 2 Points 
• Name: Match Mark 1 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

4. Follow the prompts to create a named boundary of the around the additional area. 

5. After accepting the placement of the named boundary the Create Drawing dialog will 
appear.  Ensure the following options are set: 

Top Section 

• Name: Match Mark 1 
• Drawing Seed:  40 Scale Contract Plan Sheet 

Drawing Model Section 

• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 

• Create Sheet Model: Enabled 
• Sheets: Illumination Plan [Sheet] 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

6. The existing Sheet Model will open, move the reference to the desired location on the sheet. 

7. Select Save Settings. 
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7.9 Create Blown Up Detail 
This video demonstrates how to place a 20 Scale Detail on an existing 40 Scale Sheet.   

 

 

Figure 217 

https://portal.ct.gov/-/media/dot/aec/cad-connect-dde-guide/videos/blown-up-detail.mp4
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7.10 Annotate the Drawing Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models.  Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the Sheet Models. 

1. Open a Drawing Model and use the tools on the CT DOT Ribbon’s, Annotation section to 
place Call Outs. 

 
Figure 218 

2. Match Marks are to be placed in the Drawing Model using the tools in the Notes pull down 
menu. 

 
Figure 219 
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3. Place Dimensions in the Drawing Model. To place a Dimension, select either 
the Vertical or Horizontal Text Tool on the CTDOT ribbon, then select one of the 
desired Dimensioning tools.  The Element Dimensioning dialog box will 
appear.  Enable Association and follow the prompts to place the dimension. 

 

Figure 220 

4. Light Standard Annotation.  

5. Custom labels have been created for annotating a Light Standard.  This information is 
pulled from the Item Type fields.  Select the Annotation Tab, in the Notes section 
select Place Label.  On the Place Label Settings dialog box, select the second Icon Place 
Label without a Leader.  

Select: 

Type: Text Favorite 

Favorite Name: _Illumination Light Standard Base Bottom or _Illumination Light 
Standard Base Top 
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6. Select the Light Standard cell and follow the prompts to place the annotation.  You may 
have to move the text to line up it up properly after placement. 
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7.11 Annotate the Sheet Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call-outs and Dimensions should be placed in the Drawing Models.  Placing the Call-
Outs and Dimensions in the Drawing Model will make it easier to move each detail inside 
the Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the sheet models. 

1. Use the Place Table tool on the CT DOT Ribbon to place preconfigured Tables.  Select 
the General Notes table and follow the prompts for placement. 

 

Figure 221 

2. To add information to the table select the Annotate tab and choose Edit Text.  Note: Avoid 
using the Element Selection tool to edit the table as this will lock up the file. 
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Figure 222 

3. Use the tools on the CT DOT Ribbon’s, Annotation section to place Notes. 

 
Figure 223 
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Section 8 – Landscape Sheets 

8.1 Create New File 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7. Select the New File icon. In the New dialog box browse to 
the Landscape/Contract_Plans folder. 

8. The Seed file should be set to Seed2D - CT RoadDesign.dgn. If this is not the case, click on 
the Browse button.  Browse to …CT_Configuration\Organization\Seed\Road and 
select Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 

9. In the File name field enter a name for your file using the CTDOT file naming structure 
Example: LS_CP_1234_1234_Landscape.dgn  

10. Select Save and the new file will open. 

   



VOLUME 13 – Contract Plans Production 

182 
 

8.2 Set up the Default Model 

1. Select the CTDOT workflow and click on the Attach Tab, in the References Section click 
on Attach Reference. 

2. Navigate to the Landscape Landscape\Base_Models folder and reference the Master Base 
Model file. Choose the needed Model (most likely its “Default”) and use Live Nesting at 
a Nesting Depth of 2.  

3. Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References Dialog box. 

4. Review the Attachments.  If all the needed files did not propagate to reference with Live 
Nesting in the above step, you will need to reference the files directly. If there are no Existing 
Survey users can attach Raster Images or use a Background Map, these workflows can be 
found in Volume 2 – Module 2 - Attaching Imagery and LiDAR Data. 

5. To reference the Survey navigate to the Active_Survey folder and reference the Survey 
*.dgn file.  Note: Older DGN Files will need to be referenced in with certain settings to get 
them to line up in the correct Geospatial location. 

6. For older reference files turn True Scale off and set the Scale to 1:1. Note: Always do a check 
by clicking on the Survey’s Northing and Easting Grid Marks to compare the files read out.  If 
they do not match you did not properly align the file Geospatially. 

7. Select Level Display and turn off the desired levels. 

8. Rotate the view so that the main road is parallel to the screen. On the View Window select 
the Rotate View tool.  Use the 2 Points Method. Follow the prompts to rotate the view. 

 
Figure 224 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-ebook-Volume-002---Introduction-to-OpenRoads-Designer/Module-2---Attaching-Imagery-and-LiDAR-Data
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Figure 225 

9. Select Save Settings. 
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8.3 Place Named Boundaries 

8.3.1 By 2 Point Method 

Place Named Boundary By 2 Points - used when only one sheet is needed with several details 
on the sheet.  

1. Select the CTDOT workflow and on the Annotate tab locate the Detailing section and select 
the bottom right Styles button. In the Detailing Symbol Styles dialog right click 
on CV_Detail and select Activate. 

 
Figure 226 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

 
Figure 227 
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3. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear. 

 
Figure 228 

4. In the Place Named Boundary dialog box, set the following options in the tool's settings 
window: 

• Method (icon): By 2 Points 
• Name: Landscape Plan 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

 
Figure 229 

5. Follow the prompts to place a Named Boundary (Clipping Boundary) around the design. 
Data point first in the lower left and ending in the upper right. This element can be edited 
later to refine the shape and add additional points. 

6. After accepting the placement of the named boundary the Create Drawing dialog box will 
appear.  Ensure the following options are set: 

Top Section 
• Name: Landscape Plan 
• Drawing Seed: 40 Scale Contract Plan Sheet 

Drawing Model Section 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 
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• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: 1" = 40' 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

7. Click OK. 

 
Figure 230 

  



VOLUME 13 – Contract Plans Production 

187 
 

8.3.2 Civil Plan Method 

Place Named Boundary Civil Plan - used when multiple sheets are needed along a corridor.  To 
use this method a centerline needs to be present in one of the Design Models References. 

1. Select the Place Named Boundary tool and the Place Named Boundary Dialog box will 
appear. 

 

Figure 231 

2. In the Place Named Boundary Civil Plan dialog box, ensure the following options are set in 
the tool's settings window: 

Method (icon): Civil Plan 
Drawing Seed: 40 Scale Contract Plan Sheet 
Detail Scale: 1” - 40’ 
Name: Plan 1 
Group: New 
Length: 1000 
Right Offset: -275 
Left offset: 275 
Overlap: 0 
Boundary Cord: 20 
Create Drawing: Enabled 
Show Dialog: Enabled 

  

 

 Figure 232 
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3. Follow the prompts to create a named boundary along the Centerline. 
4. After accepting the placement of the named boundaries the Create Drawing dialog will 

appear.  Ensure the following options are set: 

Drawing Model Section 
• Annotation Scale: Full Size 1” = 40’ 
Sheet Model Section 
• Sheets: New 
• Annotation Scale: 1" = 40" 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

5. Click OK.  The Drawing Models and Sheet Models will be created. 

  

Figure 233 
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8.4 Edit the Title Block 
1. The newly created sheet model will open with the Named Boundary referenced and 

centered onto the sheet. From the Ribbon open the Models dialog box. 
2. View the Properties of the model. Notice the Sheet Model’s Annotation Scale is Full Size 1 = 1. 
3. In the Properties dialog box edit or fill in the following fields: 

• Description:  LANDSCAPE PLAN 
• Sheet Number: LSD-01 

4. Notice the Drawing Title and Drawing Number in the Title Block will be updated to match 
the Properties.  The Project Number, Project Description and Town should match the 
WorkSet Properties. 

 

Figure 234   

5. Select Save Settings. 

  

8.5 Adjust the Named Boundary 
1. On the Ribbon select Home > Selection and make the Element Selection tool active. 
2. Select the Named Boundary shape and adjust by dragging the handles to the desired 

location. 
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3. The Insert Vertex or Delete Vertex tools can also be used to edit the shape. 

 

4. Return to the sheet model by hovering the cursor over the Marker and click the Signal 
Sheet and select the folder Icon (Open Target Tool). This action returns you back to the 
sheet model. Notice that by changing the boundary in the design model, this has 
propagated to the sheet. 

 

5. Models can also be opened using the View Group drop down tool located at the bottom left 
of the screen. 
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6. Select Save Settings. 

  

8.6 Move the Name Boundary inside the Sheet Border 
1. From the Ribbon click on the Models icon and select to open the Sheet Model. 
2. Select the References Icon, in the dialog box right click on the file, select Move to re-

position the reference file within the border.  
3. Follow the prompts to execute the move command. 

 

Figure 235 

4. Select Save Settings. 
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8.7 Turn off Levels 
1. Right-press and hold to bring up the contextual menu. From here, select Turn Level Off by 

Element. 

 

2. Issue a Data Point on the Named Boundary, hence turning off the level.  Data Point on other 
elements for levels you would like turned off. 

3. Select Save Settings. 
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8.8 Create Match Marked Areas 

If the design is too large for the sheet, Match Marks will be required, and additional Named 
Boundaries will need to be created.  This will be used to include side roads that extend past the 
original clipping boundary or if the main line is slightly too long to fit within the original clipping 
boundary. 

1. Go back into the Design model and place another Named Boundary adjacent to the original 
named boundary.  This will be the Match Mark.  

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the correct 
level. 

3. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear, set the following options: 

• Method (icon): By 2 Points 
• Name: Match Mark 1 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

4. Follow the prompts to create a named boundary of the around the additional area. 

5. After accepting the placement of the named boundary the Create Drawing dialog will 
appear.  Ensure the following options are set: 

Top Section 

• Name: Match Mark 1 
• Drawing Seed:  40 Scale Contract Plan Sheet 

Drawing Model Section 

• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = 40’ 

Sheet Model Section 

• Create Sheet Model: Enabled 
• Sheets: Illumination Plan [Sheet] 
• Drawing Boundary: New 
• Detail Scale: 1” = 40’ 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

6. The existing Sheet Model will open, move the reference to the desired location on the sheet. 

7. Select Save Settings. 
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8.9 Create Blown Up Detail 
This video demonstrates how to place a 20 Scale Detail on an existing 40 Scale Sheet.  

 

 

Figure 236 

https://portal.ct.gov/-/media/dot/aec/cad-connect-dde-guide/videos/blown-up-detail.mp4
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8.10 Annotate the Drawing Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models. Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the Sheet Models. 

1. Open a Drawing Model and use the tools on the CT DOT Ribbon’s, Annotation section to 
place Call Outs. 

 
Figure 237 

2. Match Marks are to be placed in the Drawing Model using the tools in the Notes pull down 
menu. 

 
Figure 238 
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3. Place Dimensions in the Drawing Model. To place a Dimension, select either 
the Vertical or Horizontal Text Tool on the CTDOT ribbon, then select one of the 
desired Dimensioning tools.  The Element Dimensioning dialog box will 
appear.  Enable Association and follow the prompts to place the dimension. 

 

Figure 239 
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8.11 Item Annotation using fields 
Coming Soon 
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8.12 Annotate the Sheet Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models.  Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the sheet models. 

1. Use the Place Table tool on the CT DOT Ribbon to place preconfigured Tables.  Select 
the General Notes table and follow the prompts for placement. 

 

Figure 240 

2. To add information to the table select the Annotate tab and choose Edit Text.  Note: Avoid 
using the Element Selection tool to edit the table as this will lock up the file. 

     

Figure 241 
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3. Use the tools on the CT DOT Ribbon’s, Annotation section to place Notes. 

 
Figure 242 
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8.13 Adding Planting Key 

Coming soon 
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Section 9 – Site Design Sheets 

9.1 Create New File 

Before attempting to open or create DGN files users should make sure the following is in place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  

4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into their 
Bentley account to secure a software license. CTDOT users should log in using your CTDOT 
email address and Bentley password. If you do not see the dialog box, select the ˄ icon on 
the bottom Windows Screen.  Click on the Connection Client Icon and select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-down 
arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7. Select the New File icon. In the New dialog box browse to 
the F_Civil\Contract_Plans  folder. 

8. The Seed file should be set to Seed2D - CT RoadDesign.dgn. If this is not the case, click on 
the Browse button.  Browse to …CT_Configuration\Organization\Seed\Road and 
select Seed2D - CT RoadDesign.dgn 

If the survey was done in an old Datum, use the 2D Seed Files in this folder  
…CT_Configuration\Organization\Seed\GCS\ 

9. In the File name field enter a name for your file using the CTDOT file naming structure. 
Example: FC_CP_1234_1234_Site.dgn 

10. Select Save and the new file will open. 

11. If it has been determined the provided survey is in NAD 27/NAVD 29 you will need to re-
project your design file’s Geospatial Header, follow Volume 2 – Module 1 - Working with 
Geographic Coordinate Systems to complete this task. 

  

https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/module-1---working-with-geographic-coordinate-systems
https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/module-1---working-with-geographic-coordinate-systems
https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/module-1---working-with-geographic-coordinate-systems
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9.2 Set up the Default Model 
1. Select the CTDOT workflow and click on the Attach tab, in the References Section click 

on Attach Reference. 
2. Navigate to the Landscape F_Civil\Base_Models folder and reference the Master Base 

Model file. Choose the needed Model (most likely its “Default”) and use Live Nesting at 
a Nesting Depth of 2.  

3. Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References dialog box. 

4. Review the Attachments.  If all the needed files did not propagate to reference with Live 
Nesting in the above step, you will need to reference the files directly. If there are no Existing 
Survey users can attach Raster Images or use a Background Map, these workflows can be 
found in Volume 2 – Module 2 - Attaching Imagery and LiDAR Data. 

5. To reference the Survey navigate to the Active_Survey folder and reference the Survey 
*.dgn file.  Note: Older DGN Files will need to be referenced in with certain settings to get 
them to line up in the correct Geospatial location. 

6. For older reference files turn True Scale off and set the Scale to 1:1. Note: Always do a check 
by clicking on the Survey’s Northing and Easting Grid Marks to compare the files read out.  If 
they do not match you did not properly align the file Geospatially. 

7. Select Level Display and turn off the desired levels. 
8. Rotate the view if desired. On the View Window select the Rotate View tool.  Use the 2 

Points Method. Follow the prompts to rotate the view. 

 

Figure 243 

https://portal.ct.gov/dot/engineering-applications/ctdot-connect-dde-ebook-volume-002---introduction-to-openroads-designer/module-2---attaching-imagery-and-lidar-data
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Figure 244 

9. Select Save Settings. 
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9.3 Create the Drawing and Sheet Models 

1. Select Level Display and turn off the desired levels. 

2. Select the CTDOT workflow and on the Annotate tab locate the Detailing section and select 
the bottom right Styles button. In the Detailing Symbol Styles dialog right click 
on CV_Detail and select Activate. 

 

Figure 245 

3. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section and 
select the Create Clipping Boundary tool. This will update the Element Template to the 
correct level. 

 

Figure 246 
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4. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear. 

 

Figure 247 

5. In the Place Named Boundary dialog box, set the following options in the tool's settings 
window: 
• Method (icon): By 2 Points 
• Name: Demolition Site Plan 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

 

Figure 248 

6. Follow the prompts to place a Named Boundary (Clipping Boundary) around the design. 
Data point first in the lower left and ending in the upper right. This element can be edited 
later to refine the shape and add additional points. 

7. After accepting the placement of the named boundary the Create Drawing dialog box will 
appear.  Ensure the following options are set: 

Top Section 
• Name: Demolition Site Plan 
• Drawing Seed: Misc Plan 
Drawing Model Section 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = ??’ (Match Detail Scale below) 
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Sheet Model Section 
• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: 1 = 1 
• Drawing Boundary: New 
• Detail Scale: 1” = ??’ (Fit View to Sheet Boundary) 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

 

Figure 249 

8. Click OK. 

9. Open the Default Design Model and repeat steps 1-5 for creating the Site / Drainage Plan 
and Grading / Geometry Plan. 
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9.4 Edit the Title Block 

1. From the Ribbon open the Models dialog box open each newly created sheet models. 

2. In the Properties dialog box edit or fill in the following fields: 

• Description: SITE GRADING PLAN 
• Sheet Number: SGP-01 

3. Notice the Drawing Title and Drawing Number in the Title Block will be updated to match 
the Properties.  The Project Number, Project Description and Town should match the 
WorkSet Properties.   

 
Figure 250 

4. Select Save Settings. 
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9.5 Adjust the Named Boundary 
1. Open the Default Design Model to edit the Named Boundaries as needed.  On the Ribbon 

select Home > Selection and make the Element Selection tool active. 
2. Select the Named Boundary shape and adjust by dragging the handles to the desired 

location. 

 

Figure 251 

3. The Insert Vertex or Delete Vertex tools can also be used to edit the shape. 

 

Figure 252 

4. Return to the sheet model by hovering the cursor over the Marker and click the Signal 
Sheet and select the folder Icon (Open Target Tool). This action returns you back to the 
sheet model. Notice that by changing the boundary in the design model, this has 
propagated to the sheet. 
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Figure 253 

5. Models can also be opened using the View Group drop down tool located at the bottom left 
of the screen. 

 
Figure 254 

6. Select Save Settings. 

  

9.6 Edit the Sheets 

9.6.1 Move the Name Boundary inside the Sheet Border 

1. Open the desired sheet model and select the References Icon, in the dialog box right 
click on the file, select Move to re-position the reference file within the border. 
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Figure 255 

2. Follow the prompts to execute the move command.  Select Save Settings. 

9.6.2 Turn off levels 

1. Open the desired sheet model and right-press and hold to bring up the contextual 
menu. From here, select Turn Level Off by Element. 
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Figure 256 

2. Issue a Data Point on the Named Boundary, hence turning off the level.  Data Point on other 
elements for levels you would like turned off.  Select Save Settings. 
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9.7 Create Blown Up Detail 

1. Open the Default Design Model. 

2. Use the Place Named Boundary tool and give your Detail a Name. 

3. Place a Named Boundary around the area you would like to detail, follow the prompts. 

4. On the Create Drawing dialog box Ensure the following options are set: 

Top Section 
• Name: Detail 
• Drawing Seed: Misc Plan 
Drawing Model Section 
• Create Drawing Model: Enabled 
• Annotation Scale: Full Size 1” = ??’ (Match Detail Scale below) 
Sheet Model Section 
• Create Sheet Model: Enabled 
• Sheets: Select the desired sheet that has already be created 
• Drawing Boundary: New 
• Detail Scale: 1” = ??’ enter the desired scale 
• Add to Sheet Index: Disabled 
• Open Model: Enabled 

5. In the Sheet Model, move the Referenced detail to the desired location.  
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9.8 Annotate the Drawing Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models. Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the Sheet Models. 

1. Open a Drawing Model and use the tools on the CT DOT Ribbon’s, Annotation section to 
place Call Outs. 

 
Figure 257 

2. Place Dimensions in the Drawing Model. To place a Dimension, select either 
the Vertical or Horizontal Text Tool on the CTDOT ribbon, then select one of the 
desired Dimensioning tools.  The Element Dimensioning dialog box will 
appear.  Enable Association and follow the prompts to place the dimension. 
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Figure 258 
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9.9 Annotate the Sheet Models 

Note: Annotation will be placed in both the Drawing Models and the Sheet Model. 

• Call outs and Dimensions should be placed in the Drawing Models.  Placing the Call Outs 
and Dimensions in the Drawing Model will make it easier to move each detail inside the 
Sheet Model’s Border as the Features and Annotation will all move together. 

• Notes that pertain to the whole sheet can be placed in the sheet models. 

1. Use the Place Table tool on the CT DOT Ribbon to place preconfigured Tables.  Select 
the General Notes table and follow the prompts for placement. 

 

Figure 259 

2. To add information to the table select the Annotate tab and choose Edit Text.  Note: Avoid 
using the Element Selection tool to edit the table as this will lock up the file.  
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Figure 260 

3. Use the tools on the CT DOT Ribbon’s, Annotation section to place Notes. 

 

Figure 261 
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9.10 Detail Sheets from 2D Drawings 
1. Continue using the DGN file created in this Module. Create a new Sheet Model, using 

the Seed2D – CT RoadSheet.dgn, 2D Sheet seed file. 

 

Figure 262 

In the Create Model dialog box enter the following: 
• Name: Miscellaneous Details 
• Description: Miscellaneous Details 
• Sheet Number: C-005 
• Annotation Scale: Full Size 1 = 1 

 

Figure 263 
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2. Activate the CTDOT Workflow, on the CTDOT tab, Sheet Production area select 
the Borders drop down and choose Contract Border. Attach the Contract Border to the 
Sheet Boundary. 

 

Figure 264 

3. In Search type Update All Fields, select the result and the Drawing Title and Drawing 
Number will propagate to what was entered when the sheet was created. 

 

Figure 265 

  

4. Create a new 2D Design Model, using the Seed2D – CT RoadDesign.dgn, Default seed file. 
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Figure 266 

5. In the new 2D Design Model activate the CTDOT Workflow. On the Home tab, use the 
Placement, Manipulate and Modify tools to draft the line work for the Details. Multiple 
details can be placed in this design model as these will all be placed at their true size 1:1. 
There will be no dimensioning or text placed in this model, all annotation will be in the 
Sheet Model that will reference the 2D design model’s line work. 

6. In search type Detailing Symbol Styles, select the result and the dialog box will open. 
Right click on CV DETAIL and select Activate. 

7. On the CTDOT Tab, Sheet Production section select Create Clipping Shape, this will set 
the correct level for the clipping shape. In the same section select the Place Named 
Boundary tool. 

8. On the Place Named Boundary dialog box select the By Two Point icon, Name the Detail 
(ANTI-TRACKING PAD) and make sure Create Drawing is on. Follow the prompts and 
place a shape around one of the details. 

On the Place Named Boundary dialog box set: 
Drawing Seed: Place Sheet Only (Named Boundary) 
Sheets: Select the Sheet Model created in step 1 of this section 
Detail Scale: As needed 
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Figure 267 
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9. The sheet Model will open, move the referenced detail to the desired location inside the 
sheet. 

10. Open the 2D Design Model to create another Named Boundary around the same detail. 

11. In search type Detailing Symbol Styles. Select the result and the dialog box will open. 
Right click on CV Center Style and select Activate. 

12. On the CTDOT Tab, Sheet Production section select Create Clipping Shape, this will set 
the correct level for the clipping shape. In the same section select the Place Named 
Boundary tool. 

13. On the Place named Boundary dialog box select the By Two Point icon, Name the Detail 
(ANTI-TRACKING PAD – Different Scale) and make sure Create Drawing is on. Follow the 
prompts and place a shape around the detail. 

 

Figure 268 

On the Create Drawing dialog box set: 
• Drawing Seed: Place Sheet Only (Named Boundary) 
• Sheets: Select the Sheet Model created in step 1 of this section 
• Detail Scale: Different than used in Step 8 
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Figure 269 

15. The Sheet Model will open, move the referenced detail to the desired location inside the 
sheet.  

16. In the Sheet Model place dimensions on both details, notice they both dimension correctly 
even though they are two different sizes on the sheet. 
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Figure 270 

16. Review the titles of each detail and the Detailing Symbol Styles that were used.  The first one 
used the CV DETAIL and the second CV Center Style.   CV DETAIL should be used if there is 
a need to call out this detail on another sheet. 

 

Figure 271 
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Section 10  -  Bridge Sheets 

10.1  General Plan Sheet 

This module will instruct users on how to create contract sheets using the Named Boundaries 
and Detailing Call Out tools. Users will create a DGN file that will be composed of different 
models to create the Sheet Model. This workflow is written to create detail sheets for a bridge 
created using OpenBridge Modeler.  Similar detailing methods can be used for other 3D 
Structures created by using the Solids tools such as: 

• Retaining Walls 
• Tunnels 
• Sign Supports 
• Traffic Signal Support/Span Poles 
• Drainage Structures/Box Culverts 

Contract Sheet files will be stored in the Contract Plans folder.  A DGN file will be created with 
the structure’s Base Model referenced in, this file will house all the Sheet Models for the 
Structure.  

When this file gets created it will only have a Design Model. The following Base Model DGN files 
will need to be referenced in: 

• Bridge Base Model 
• Survey files (ground topo and terrain) 
• Other Design unit’s Base Models (Highway, Traffic, Illumination and Landscape) 
• The Named Boundary and Callout tools will be used to create additional models in this 

DGN file which will be a combination of Drawing and Sheet Models. 

10.1.1 Create a New file 

Before attempting to open or create DGN files users should make sure the following is in 
place: 

1. CTDOT users should have the CTDOT CONNECT DDE synced through SharePoint with the 
COMPASS Project Synced along with the CAD Configuration. 

2. Consultants should have CTDOT DDE properly installed or be syncing to the CTDOT DDE 
SharePoint/COMPASS system. 

3. Make note of the Coordinate System you will be working in. If you have existing survey 
data, you will need to find out what system is being used (NAD 83/NAVD 88 or NAD 
27/NAVD 29).  
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4. Log on to the CONNECTION Client. Bentley CONNECT licensing requires users to log into 
their Bentley account to secure a software license. CTDOT users should log in using your 
CTDOT email address and Bentley password. If you do not see the dialog box, select 
the ˄ icon on the bottom Windows Screen.  Click on the Connection Client Icon and 
select Open. 

5. Access OpenRoads through Accounting or the Customized Icon following  

6. On the OpenRoads open screen select Custom Configuration, using the small drop-
down arrows select the Workspace CT_Workspace, the needed WorkSet and Role. 

7. Select the New File Icon. In the New dialog box browse to 
the Bridge\Contract_Plans folder. 

8. The Seed file should be set to: 

…CT_Configuration\Organization\Seed\Bridge\Seed3D - CT BridgeDesign.dgn 

9. In the File name field enter a name for your file using the CTDOT File Naming structure. 

Example:  SB_CP_1234_1234_Bridge#.dgn 

10. Select Save and the new file will open. 

11. If you need the Geospatial Header in a different Datum, please follow instruction in 
Volume 2. 

10.1.2 Set up the Design Model 

1. Select the CTDOT workflow and click on the Attach tab, in the References Section click 
on Attach Reference. 

Reference the needed Proposed Base Model dgn files including but not limited to: 

• Bridge/Structures 
• Signal 
• Signing and Pavement Markings 
• Roadway Alignment 
• Highway 
• Drainage 
• Illumination 

2. In the Attach Reference Box browse and select the desired file and click Open.  In the 
Reference Attachment Dialog Box choose: 

• Model: Most likely it’s “Default” but this could vary depending how the file has been 
set up. 

• Nested Attachments: No Nesting 
• Global LineStyle Scale: Master 
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3. Click OK to finish the attachment process. 

4. Repeat Steps 1 - 3 for all Proposed Base Models 

5. Reference the Existing Survey dgn files.  Select the CTDOT workflow and click on 
the Attach tab, in the References Section click on Attach Reference.  

6. In the Attach Reference Box browse to the Active Survey Folder and select the desired 
Existing Survey DGN file and click Open.  In the Reference Attachment Dialog Box choose: 

• Model: Most likely it’s “Default” but this could vary depending on how the file has 
been set up. 

• Nested Attachments: No Nesting 
• Global LineStyle Scale: Master 

7. Click OK to finish the attachment process. 

8. If the Survey does not line up with the Proposed Design File it is most likely an older 
Survey File that was created with V8i.  Older files will need to be referenced in with 
certain settings to get them to line up in the correct geospatial location.   

9. Select the Home Tab, in the Primary Section select the Attach Tool drop down and 
choose References. This will open the References Dialog box. 

10. Turn True Scale off and set the Scale to 1:1.   

11. The Existing Survey File reference will need its levels set to SCREENED for when the PDF 
plans are created.  This can be done by using a specific Logical Name in the Reference 
Attachment Properties.  SWW Ground Survey will leave all levels in the reference 
screened with the displayed line weights when the PDF is created. 
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Figure 272 

  

12. Right click in View 1 and select 2 Views Plan/3D. 

 
Figure 273 

13. Select Level Display and turn off or on the desired levels in each Reference for Views 1 
and 2. 

14. Select Save Settings. 
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10.1.3 Create the General Plan 

1. In the DGN file created in the section above, create a new 2D Design Model. 
In Search type Models and select the result. In the Models dialog box click on the Create 
a new model icon. On the Create Model dialog box select: 

Type: Design from Seed 

2. Change the Seed Model by clicking on the button next to Seed Model. On the Select File 
Containing Seed Model dialog box select Seed2d_CT Bridge.dgn.  Click 
the Open button. On the Select Models dialog select 2D Design and OK. 

 
Figure 274 

Figure 275 

3. Name the Model 2D Design and click OK. 
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Figure 276 

4. Reference in the 3D Model Created in the section above using a Nested Depth of 1.  Fit 
View 1. 

5. In Search type Detailing Symbol Styles and select the result.  In the Detailing Symbol 
Styles dialog box activate the Center Title Detailing Style. 

 
Figure 277 

6. Rotate View 1 so the Bridge is Square with the view. In the Key-in enter rotate view 
element and follow the prompts to select a longitudinal line on the bridge. Note: If the 
Key-in is not docked on the screen type Key-in in search to open the tool. 

7. Select Save Settings. 

8. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section 
and select the Create Clipping Boundary tool. This will update the Element Template 
to the correct level. 

 
Figure 278 
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9. Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear. In the Place Named Boundary dialog box set the following options: 

• Method (icon): By 2 Points 
• Name: General Plan 
• Mode (icon): Place Single Named Boundary 
• Create Drawing: Enabled 

 
Figure 279 

10. Follow the prompts to place a Named Boundary (Clipping Boundary) around the 
design. Data point first in the upper right and ending in the lower left.  This element 
can be edited later to refine the shape and add additional points. 

11. After accepting the placement of the named boundary the Create Drawing dialog 
box will appear.  Ensure the following options are set: 

• Name: General Plan 
• Drawing Seed: Plan (Named Boundary) 
• Create Drawing Model: Enabled 
• Annotation Scale: Match the Detail Scale in the Sheet Section 
• Create Sheet Model: Enabled 
• Sheets: New 
• Annotation Scale: Full Size 1 = 1 
• Drawing Boundary: New 
• Detail Scale: 1” = 30’ (or as Desired) 
• Add to Sheet Index: Disabled 
• Open Model: Enabled  

12. Click OK to continue. 
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Figure 280 

13. A Drawing Model and Sheet Model will be created. In the bottom left of the 
application select and view the three models that are now in the file. 

 
Figure 281 

14. Open the Design Model and adjust the Named Boundary as needed. 

15. Open the Sheet Model and move the Referenced Plan View of the Bridge to the Left 
Top of the sheet. Use the Selection tool to move the Detail Title as needed. 
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Figure 282 

10.1.4 Edit the Title Block 

In this section we will edit the title block information.  In the Models Dialog select the Sheet 
Model and in the Properties dialog box enter the “Drawing 
Title” Description and “Drawing Number” Sheet Number, 

Note: The Project Number, Project Description and Town(s) will be auto populated by the 
WorkSet Properties. 
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Figure 283 



VOLUME 13 – Contract Plans Production 

234 
 

10.1.5 Add Additional Details to the Sheet 

In this section we will add the following details to this sheet. 
• Cross Section 
• Elevation View 
• Blow up Detail 
• Isometric View 

 
1. In the same dgn file created in the section above open the 3D Design Model. 
2. Use the CTDOT workflow and click on the Annotate tab. In the Detailing section 

select Section Callout. 

 
Figure 284 

3. In the Place Section Callout dialog box select the following: 

• Drawing Seed: Section - Centered 
• Height: From Model 
• Toggle on Create Drawing 

 
Figure 285 
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4. Follow the prompts to place a section cut. 

 
Figure 286 

5. In the Create Drawing dialog box change Sheets: to General Plan [Sheet], this will place 
the Section in the previously created Sheet Model (General Plan). In the Sheet Model 
section select a Detail Scale and match the Drawing Model's Annotation Scale to that 
Detail Scale. 

 
Figure 287 
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6. Open the Sheet Model and notice it may need to be clipped to show less of the 
elevation.  Open the Design Model, in View 2 move the Clipping Shape limit closer to the 
deck. 

 
Figure 288 
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7. Open the Sheet Model and move the referenced Section to the bottom right corner of 
the sheet, notice the new clip is reflected.  Move the Detail Symbol so it lines up in the 
center under the detail. Turn off the existing ground files and other referenced files that 
are not needed.  For Reference files that have been kept on turn off the unneeded 
levels. Save Settings. 

 
Figure 289 

8. Return to the 3D Design Model 
9. On the CTDOT workflow click on the Annotate tab.  In the Detailing Section 

select Elevation Call out. 

 
Figure 290 
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10. In the Place Elevation Callout dialog box select the following: 

• Drawing Seed: Elevation - Centered 
• Height: From Model 
• Toggle on Create Drawing 

 
Figure 291 

11. Follow the prompts to place a cut. 

 
Figure 292 
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12. In the Create Drawing dialog box change Sheets: to General Plan [Sheet], this will place 
the Section in the previously created Sheet Model (General Plan). Set the Detail 
Scale to match the General Plan’s Scale.  Match the Drawing Model's Annotation 
Scale to the Detail Scale. 

 
13. In the 3D Model adjust the clipping as needed. 
14. In the Sheet Model turn off the unneeded Reference files and Levels. Save Settings. 

 
Figure 293 
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10.1.6 Place a Blow-up Detail 

1. Open the Section Drawing Model. 

2. In the Models dialog select the Section Drawing Model. In Properties change 
the Annotation Scale to 1/8” = 1’-0”. 

 
Figure 294 

3. Use the Place Detail Callout tool, follow the prompts and place a circle around the area 
of the detail you need to blow-up. 

 
Figure 295 

4. In the Place Detail Callout dialog box select the following: 

• Drawing Seed: Detail 
• Toggle on Create Drawing 

Select the desired Placement Shape/Method Icon (Circle, Oval, Rectangle or Existing 
Boundary). 
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Figure 296 

5. Follow the prompts. 

 
Figure 297 

6. Give the Detail a Name and change Sheets: to General Plan.  Set the Detail Scale to 
match the Drawing Model's Annotation Scale that was set above in Step 2.  Match the 
Drawing Model's Annotation Scale to the Detail Scale. 
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Figure 298 

7. The General Plan Sheet will open.  Move and Scale the Referenced Beam Detail as 
needed.  Turn off un-needed levels and nested references.  Save Settings. 
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Figure 299 

8. Click on the Magnifying Glass located on the Section Detail and click Show Callouts. 
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Figure 300 
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10.1.7 Place an Isometric View to the Sheet 

1. Create a new 3D Design Model called Isometric View. Edit the preset Ref Logical Name 
of General Plan as needed. 

 
Figure 301 

2. Reference in the original 3D Model named Design using a Nested Depth of 1. Turn off 
unneeded levels and reference files. 

3.  On the View Window select the View Attributes icon, choose a Display Style.  Rotate the 
view as needed. Save Settings. 
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Figure 302 

4. In Search type Saved Views and select the result.  In the Saved Views dialog box click 
on the Create Saved View icon.  Give your view a name and follow the prompts to 
create a Saved View. 

 
Figure 303 
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5. Open the General Plan Sheet Model. 
6. In Search type Detailing Symbol Styles and select the result.  In the Detailing Symbol 

Styles dialog box activate the Center Title Detailing Style. 

 
Figure 304 

7. Reference the Saved View using the following settings: 

• Model: Isometric View 
• Orientation: Isometric View 
• Detail Scale: 1/16” = 1’-0” 
• Nesting Attachments: Live Nesting 
• Nesting Depth: 2 

 
Figure 305 



VOLUME 13 – Contract Plans Production 

248 
 

8. Move the Reference in the sheet as needed. Save Settings. 

 
Figure 306 
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10.1.8 Annotate the Models 

Most annotations for a detail should occur in the drawing model if there is one. The only 
annotation on the sheet model will be things like general notes, sheet border annotation, table 
of quantities, etc. 

1. Open the desired Drawing or Sheet Model.  Select the CTDOT Workflow and choose 
the CTDOT tab. In the Dimensioning section start by selecting the Horizontal Text icon and 
select the desired accuracy. This will set the proper dimension style and Level. 

2. Second select the needed Dimensioning Tool. 

3. Follow the prompts to place a dimension. 

 
Figure 307 

4. Select the CTDOT Workflow and choose the CTDOT tab.  In the Annotation section 
select Place Table. There is a table seed for the General Notes available in the Table 
Tool.  On the Place Table Dialog Box select Seed: General Notes and proceed to place the 
table. 

 
Figure 308 

 
Figure 309 
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5. In the same Annotation section select the pull-down menus for Call Outs and Notes to 
place the needed annotation. 

6. To place a call out with an inserted symbol use the following procedure.  In the Annotation 
Section of the CTDOT tab select the Call Out Tool Label Small (Weight 0) 

Note: Selecting the (Weight 0) options places the leader at a line weight of 0 and selecting 
the (Weight 2) options places the leader at a line weight of 2. 

7. In the Text box type the following:  SYMMETRICAL ABOUT CL FIELD SPLICE 

8.  In the Text box select only the CL text, select the Insert Text Favorite tool and scroll down 
to Symbol CL – Small.  The CL text will be replaced with the required Symbol. 

Note: Use the Text Favorite Symbol CL - Small in conjunction with Text 
Style CTDOT_080 and Symbol CL for Text Style CTDOT_120. 

9. Follow the prompts to place your call out. 

 
Figure 310 
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10.2 Civil Plans 

10.2.1 View Set Up 

Continue using the DGN file created in Volume 13 - M.4.1 General Plan Sheet and open the 
Design Model. We will use a referenced roadway alignment Base Model to create Plan, Profile 
and Cross Section Sheets. The (referenced) Alignment Base Model should have a horizontal 
alignment placed along with an active vertical alignment set.  For more on creating alignment 
base models visit Volume 3 - Module 2 - Creating Alignments 

1. The Referenced Existing Terrain should be set to active. In View 1 turn on the Reference with 
the needed terrain, select the terrain’s boundary and on the pop-up tool select Set As 
Active Terrain Model. 

 
Figure 311 

2. Open the Design Model, Right click in a View and Select 3 Views Plan/Profile/3D. 

 
Figure 312 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-ebook-Volume-003---OpenRoads-Designer-Roadway-Modeling/Module-2---Creating-Alignments
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3. Follow the prompts to View the Profile.  Save Settings. 

 
Figure 313 

4. In View Group notice a Multi-Model View has been created. 

 
Figure 314 
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10.2.2 Create Civil Plan Sheet 

1. In View Group select the Multi-Model View. 
2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section. 

Select the Place Named Boundary tool and the Place Named Boundary dialog box will 
appear.  In the Place Named Boundary dialog box set the following options: 
• Method (icon): Place Named Boundary Civil Plan 
• Drawing Seed: Select the desired scale 
• Name: Plan 1 
• Group: (New) 
• Name: Match alignment name (Clicking on the horizontal alignment will also 

populate this name field with the name of the horizontal alignment.) 
• Length: Use Default Value or adjust as needed (length of alignment on one sheet). 
• Left Offset: Use Default Value or adjust as needed (offset from the alignment). 
• Right Offset: Use Default Value or adjust as needed (offset from the alignment). 
• Overlap: 0 (value of sheet overlapping the other) 
• Boundary Chords: Use Default Value or adjust as needed. 
• Create Drawing: Enabled (so that the sheets are created as soon as the named 

boundaries are created) 
• Show Dialog: Enabled (used to override settings defined by the Drawing Seed if 

needed) 

3. In the Plan view select the alignment along which the plan named boundaries will be 
created.  The command line (lower left corner) will read: Place Named Boundary Civil 
Plan > Identify Path Element.   With the cursor, select the alignment.  

4. Select the desired Start Location.  Follow the prompts.  Command Line: Place Named 
Boundary Civil Plan > Accept/Reject. Identify Path start point to place 
boundary.  Follow the prompts. 

5. Note: Add extra to the left of the start of your Stationing, example: Beginning Station is 
100+00, at Start Location type in 99+00, this will move the named boundary to the left of 
the start of alignment.  Bring your cursor back into the dialog box, enter the Start 
Station, click the Tab button, back in the view left click to Accept.  

6. Next select the Stop Location. Command Line: Place Named Boundary Civil Plan > 
Identify Path end point to place boundary.  The named boundaries are displayed 
interactively as the cursor moves.  Accept the endpoint location for the named 
boundary.  Command Line: Place Named Boundary Civil Plan > Accept/Reject. 
Datapoint point in Plan View to place boundary.  Identify Path end point to place 
boundary. 
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Figure 315 

7. The Create Drawing dialog box will appear.  Leave all the top settings as is. 

8. Enable the Add to Sheet Index and the Open Model options. 

9. Click OK to create the sheets.  Follow the prompts in the lower left corner left click to 
define the named boundaries. Multiple left clicks may be required. 
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10.  
11. Figure 316 

12. In the View Group dialog, you can now see the newly created drawing model(s) and 
sheet model(s). 
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13.  
14. Figure 317 

10.2.3 Create Civil Profile Sheet 

1. In View Group select the Multi-Model View. 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section 
and select the Place Named Boundary tool and the Place Named Boundary dialog box 
will appear.  In the Place Named Boundary dialog box set the following options: 

• Method (icon): Place Named Boundary Civil Profile. 
• Drawing Seed: Select the desired scale. 
• Name: Profile 1 
• Method: Choose Station Limits or From Plan Group ( The From Plan Group 

method matches the profile named boundaries to the plan named boundaries. 
The Station Limits method is used to defined profile named boundaries that are 
not matched to plan boundaries.) 

• Group: (New) 
• Name: Match alignment name (Clicking on the horizontal alignment will also 

populate this name field with the name of the horizontal alignment.). 
• Length: Use Default Value or adjust as needed. 
• Vertical Exaggeration: 10 
• Available Profile Height: Use Default Value or adjust as needed. 
• Top Clearance: (toggled on) Use Default Value or adjust as needed. 
• Bottom Clearance: (toggled on) Use Default Value or adjust as needed. 
• Elevation Datum: Use Default Value or adjust as needed. 
• Station Datum: Use Default Value or adjust as needed. 
• Use Terrains: Enabled 
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• Use Active Vertical: Enabled 
• Create Drawing: Enabled 
• Show Dialog: Enabled 

Follow the prompts in the lower left corner left, Command Line: Place Named Boundary 
Civil Profile > Identify Profile View click in the Profile View to define the named 
boundaries. More than one click is required. 

 
Figure 318 

3. The Create Drawing dialog box will appear.   
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4. For Sheets: select a new sheet or chose to put the profile on a sheet that has already 
been created. 

5. Click OK to create the sheets.  Follow the prompts in the lower left corner left click to 
define the named boundaries. Multiple left clicks may be required. 

 
Figure 319 

Please visit modules in OpenRoads Drawing Production for further instruction on the 
following items: 

Review Plan and Profile Sheets 

Review Named Boundaries 

Adjust Sheet Layout 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Review%20Plan%20and%20Profile%20Sheets
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Review%20Named%20Boundaries
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Adjust%20Sheet%20Layout
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Deleting Sheets 

Label - Horizontal Alignment 

Label – Profile (Vertical Alignment) 

  

  

10.2.4 Create Civil Cross Section Sheets 

We will use the Referenced Roadway/Bridge Alignment Base Model to create Profile Sheets. 
The (referenced) Alignment Base Model should have a horizontal alignment placed along 
with an active vertical alignment set. 

1. In View Group select the Multi-Model View. 

2. Select the CTDOT workflow and on the CTDOT tab locate the Sheet Production section 
and select the Place Named Boundary tool. In the Place Named Boundary dialog box 
set the following options: 

• Method (icon): Place Named Boundary Civil Cross Section. 
• Drawing Seed: Select the desired scale. 
• Group: (New) 
• Name: Match the alignment name (Clicking on the horizontal alignment will also 

populate this name field with the name of the horizontal alignment.). 
• Create Drawing: Enabled 
• Show Dialog: Enabled 

The drawing seed has been set-up for the ANSI D size paper (34”x22”), and defaults 
include: 

• Named Boundary, for left and right offsets, section intervals, vertical exaggeration, 
and top and bottom clearances between sections (these can be changed if 
needed). 

• Include Control Points, these are usually the PC’s, PI’s, PT’s of the horizontal 
alignment. 

• Include Event Points Only, this will require the user to establish an Event Point List 
(drainage crossings as example). 

  

3. In the 2D view (default plan view), select the alignment along which the named 
boundaries (sheets) will be created.  The command line (lower left corner) will 
read: Place Named Boundary Civil Cross Section > Identify Path Element.   With the 
cursor select the horizontal alignment.  Now a light blue line should be visible on the 

https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Deleting%20Sheets
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Label%20-%20Horizontal%20Alignment
https://portal.ct.gov/DOT/Engineering-Applications/CTDOT-CONNECT-DDE-eBook-Volume-013---Contract-Plans-Production/Plan-and-Profile-Sheets#Label%20%E2%80%93%20Profile%20(Vertical%20Alignment)
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cursor.  This allows the user to pick the start and stop locations of the named 
boundaries for cross sections. 

4. Select the desired Start Location.  Follow the prompts.  Command Line: Place Named 
Boundary Civil Cross Section > Accept/Reject. Identify Path start point to place 
boundary. 

5. Next select the Stop Location.  Command Line: Place Named Boundary Civil Cross 
Section > Identify Path end point to place boundary.  The named boundaries are 
displayed interactively as the cursor moves.  Accept the endpoint location for the 
named boundary.  Command Line: Place Named Boundary Civil Cross Section > 
Accept/Reject. Datapoint point in Plan View to place boundary.  Identify Path end 
point to place boundary. 

  

Figure 320 

  

6. The Create Drawing dialog box will appear. 

7. Click OK to create the sheets.  At the bottom of the view windows, a gage will appear 
showing the progress of Sheets Created and then the progress of Drawing Models 
Annotated.  When all is completed the last cross section sheet will be open. 
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Figure 321 
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10.3 Detail Sheets from 2D Drawings  

1. Continue using the DGN file created in Volume 13 - M.4.1 General Plan Sheet. Create a new 
Sheet Model, using the Seed2D – CT BridgeSheet.dgn, Sheet seed file. 

 
Figure 322 

2. Create a new 2D Design Model, using the Seed2D – CT BridgeDesign.dgn, 2D Design seed 
file. 

 
Figure 323 
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3. In the new 2D Design Model activate the CTDOT Workflow. On the Home tab, use the 
Placement, Manipulate and Modify tools to draft the line work for the Details. Multiple details 
can be placed in this design model as these will all be placed at their true size 1:1. For this 
exercise you will need to create at least 2 details. There will be no dimensioning or text 
placed in this model, all annotation will be in the Sheet Model that will reference the 2D 
design model’s line work. 

4. In search type Detailing Symbol Styles. Select the result and the dialog box will open. Right 
click on Center Style and select Activate. 

5. On the CTDOT Tab, Sheet Production section select Create Clipping Shape, this will set the 
correct level for the clipping shape. In the same section select the Place Named 
Boundary tool. 

 
Figure 324 



VOLUME 13 – Contract Plans Production 

264 
 

6. On the Place Named Boundary dialog box 
select the By Two Point icon, Name the Detail 
(DETAIL - TYPICAL PARAPET END) and make 
sure Create Drawing is on. Follow the 
prompts and place a shape around one of 
the details. 

On the Place Named Boundary dialog box set: 

Drawing Seed: Place Sheet Only (Named 
Boundary). 

Sheets: Select the Sheet Model created in 
step 1 of this section. 

Detail Scale: As needed. 

 

 

 

 

 

 

 

 

 

 

 

Figure 325 
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7. The sheet Model will open, move the referenced detail 
to the desired location inside the sheet. 

8. Open the 2D Design Model to create another Named 
Boundary. 

9. Activate the Default Detailing Symbol Style. 

10. On the CTDOT Tab, Sheet Production section 
select Create Clipping Shape, this will set the correct 
level for the clipping shape. In the same section select 
the Place Named Boundary tool. 

11. On the Place named Boundary dialog box select 
the By Two Point icon, Name the Detail (SECTION – R-
B 350 ATTACHMENT) and make sure Create 
Drawing is on. Follow the prompts and place a shape 
around another detail. 

On the Place Named Boundary dialog box set: 

Drawing Seed: Place Sheet Only (Named Boundary). 

Sheets: Select the Sheet Model created in step 1 of 
this section. 

Detail Scale: As needed. 

 

 

Figure 326 

  

12. The Sheet Model will open, move the referenced detail to the desired location inside the 
sheet. 
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13. Open the 2D Design Model to create another 
Named Boundary, assure the Named Boundary 
Element Template is active. Zoom in and place a 
circle around a portion of a detail. On the Place 
Named Boundary dialog box select the By 
Element icon. Give the detail a name (BOLT 
DETAIL). Use a Detail Scale to enlarge the size on 
the Sheet. 

On the Place Named Boundary dialog box set: 

Drawing Seed: Place Sheet Only (Named 
Boundary). 

Sheets: Select the Sheet Model created in step 1 
of this section. 

Detail Scale: As needed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Figure 327 
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14. In the Sheet Model place dimensions on both details (the full detail and the blown-
up detail, notice they both dimension correctly even though they are two different sizes on 
the sheet. 

 
Figure 328 

15. Use the Section Call Out tool and place a Detailing Symbol to indicate cut section. Edit the 
text in the Bubble to indicate the Detail it is referring to. 

16. To Create a Step or a Gap in a Section or Plan Callout do one of the following: 

Right-click the callout and select Create Step from the pop-up menu or Right-click the 
callout and select Create Gap from the pop-up menu. 

 
Figure 329 
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10.4 Place Welding Symbol 

The tool Place Welding Symbol can be accessed through OpenBridge Designer that comes 
with the ProStructures component. It’s important to note that users that only have OpenBridge 
Modeler and OpenRoads Designer installed will not be able to access this tool. This is how 
Bentley has decided to program and license this tool and it is no longer available as the 
“Detailer” MDL Application that ran on the MicroStation V8i platform.  CTDOT put in a request to 
Bentley for a rewrite of this MDL Application to work across all their CONNECT Edition CAD 
programs, but they have decided to only offer it through OpenBridge 
Designer/ProStructures.  CTDOT spent a considerable amount of time trying to get the Place 
Welding Symbol tool to work as well as the old MDL Detailer Application.  We came up with this 
workflow to outline the workarounds needed until Bentley addresses the issues. 

Three tools have been created on the CTDOT Workflow; Bridge Tab too address the 
workarounds settings for the Welding Symbol placement. 

❶ Set Welding Symbol Detail Accuracy 

❷ Label (Weight 0) 

❸ Open Welding Finishing Symbols 

We have also placed access to the ❹ Place Welding Symbol tool on the CTDOT workflow. 

  

Figure 330 
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Steps: 

1. Open the DGN File that will be used to place Welding Symbols.  

2. Select the CTDOT Workflow, Bridge tab.In the Detail section select the Set Units pull down 
and choose Set Welding Detail Accuracy. This will set the Working Units to what is needed 
to have the numbers show correctly in the Welding Symbol. 

These are the settings that will be auto updated by the Set Welding Detail Accuracy tool: 
Format: MU 
Master Unit: Inches                 Label: in 
Sub Unit: Inches                        Label: in 

 
Figure 331 

3. Remain on the CTDOT workflow Bridge tab, Detail section and select: Annotate > Label 
(Weight 0), this will set the needed Text Style. 

4. To add a welding symbol, remain on the CTDOT workflow Bridge tab, Detail section and 
select: Annotate > Place Welding Symbol 

5. Select the  Help button at the bottom of the dialog box to access Bentley’s online help. 
This will cover in detail the use of the Weld Styles Dialog Box. 

6. Under Level select ANNOT_Label_Proposed. 
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Figure 332 

7. Select and fill in the following: 

• Weld Style, note: if the style needed is not listed just pick the closest one and this can be 
edited after placing the initial note. 

• Welding Thickness (add top side and bottom side if they are both needed) 

•  Weld Group Settings 

8. Select  Add Welding Symbol and follow the prompts to place the symbol. 

9. After placement the Symbol can be easily edited by double clicking on the symbol in the 
DGN. Edit as needed in the Welding Symbol Properties, when complete select the Green OK 
check box. 

 
Figure 333 
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Please Note: 
• The Towards Position button and options do not work to CTDOT standards so do not 

toggle this on, Finishing Symbols will be added using cells from a cell library (see step 
10). 

• The Fraction style can also be customized to use either Horizontal or Diagonal Stacking. 

10. To add finishing symbols, remain on the CTDOT workflow Bridge tab, Detail section and 
select: Annotate > Open Welding Finishing Symbols 

A Cell Library will open, select as needed and follow the prompts to place the cell near the 
welding Symbol. 

 
Figure 334 

11. When you are done placing Welding Symbols select Save Settings to hold the Design Files 
settings for the next time you open the file or select other Design Files settings, working 
Units options as needed for other call outs. 
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Section 11 - Sheet Indexing 
The Explorer Dialog Sheet Index Tab contains controls to manage sheet indexing. 

A sheet index is an organized and named collection of sheet models from one or more design 
files. You may link any sheet model from any design file into a sheet index. You can then manage 
the properties of all the sheet models within the sheet index collectively. Sheet indexes may also 
be added to print organizer print sets for printing. 

 
Figure 335 

Refresh - Refreshes the content of the sheet index. Though the sheet index automatically 
refreshes when you make any changes, in some cases, you may need to refresh it manually by 
clicking this icon. 

Open Sheet Index for Edit - Allows you to make changes to the sheet index. When you click this 
icon, other users cannot make changes to the sheet index. 

Make Sheet Index Read Only - Turns off editing options on the sheet index. When you click this 
icon, the changes made to the sheet index are saved and other users can make changes to the 
sheet index. 
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Manage Sheet Index - Opens the Manage Sheet Index dialog in which you can manage the sheet 
index and its properties. 

• Create Folder - Creates a new folder in the sheet index. 

• Add Sheet - Opens the Add Sheet dialog from where you can select the file from which you 
want to add sheet links. 

• Delete - Deletes the selected folder or sheet link from the sheet index. If the folder contains 
links or other folders, they are deleted as well. 

• Place as Table - Starts the Place Table tool to place the index sheet. An index sheet 
contains properties of all the sheets in the sheet index that is placed as a table. Once 
placed, a report definition of the index sheet is also created in the Reports dialog. 

• Open Print Organizer - Opens the Select Print Style dialog. Selecting the desired print style in 
the Select Print Style dialog and clicking OK opens the Print Organizer. The Sheet Index 
displays in the Print Organizer. You can compose a new print set file using the sheet index. 

Reset pop-up menu for sheet index - Right-clicking the sheet index opens a pop-up menu with 
following options: 

• Validate - Verifies that all the targets in the sheet index still exist in the locations to which 
the links point. If any targets do not exist, the sheet names turn red. They remain red until 
you revalidate and confirm that all targets in the folder exist in the specified locations. 

• Add Sheet - Opens the Add Sheet dialog from where you can select the file from which you 
want to add sheet links. 

• Update Sheet Model Properties - If you make changes to the properties in the sheet index, 
selecting this option updates those properties in the sheet model. 

• Details - Opens the Details dialog displaying the properties of the sheet index. 

• Properties - Opens the Properties dialog displaying the properties of the sheet index. 

Reset pop-up menu for folders - Right-clicking a folder opens a pop-up menu with following 
options: 

• Validate - Verifies that all the targets in the folder still exist in the locations to which the links 
point. If any targets do not exist, the sheet names turn red. They remain red until you 
revalidate and confirm that all targets in the folder exist in the specified locations. 

• Add Sheet - Opens the Add Sheet dialog from where you can select the file from which you 
want to add sheet links. 

• Update Sheet Model Properties - If you make changes to the properties in the sheet index, 
selecting this option updates those properties in the sheet model. 

• Rename - Allows you to key in a new name for the selected folder. 
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• Details - Opens the Details dialog displaying the properties of the folder. 

• Properties - Opens the Properties dialog displaying the properties of the folder. 

Reset pop-up menu for sheet links - Right-clicking a sheet opens a pop-up menu with following 
options: 

• Validate - Verifies that the target sheet still exists in the locations to which the links point. If 
any targets do not exist, the sheet names turn red. They remain red until you revalidate and 
confirm that all targets in the folder exist in the specified locations. 

• Update Sheet Model Properties - If you make changes to the properties in the sheet index, 
selecting this option updates those properties in the sheet model. 

• Open - Opens the selected sheet. 

• Add Link to Element - Adds the sheet link to the selected element in the open DGN file. 

• Details - Opens the Details dialog displaying the properties of the sheet link. 

Properties - Opens the Properties dialog displaying the properties of the sheet link. 
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Section 12 Revisions 
 
Revision List 
4/12/2024 
Volume Section/Module  Description  

 13 Section 1 
Modified the Contract Border Title Block integration - Designed By / 
Checked By 

 13 Module 2.3 New Module - Revision Index Sheet 

 13 Module 4.4 New Module - Place Welding Symbol 
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